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About this Manual 
The MPM Standard Reports manual describes how to create 
reports of the project data. The components include: 

Creating Reports 
Details of each report 

MPM Documentation Set 
The MPM Standard Reports manual is part of a documentation 
set that includes: 

Installation 
Guide 

This guide describes the system 
requirements as well as how to install 
MPM, Data Warehouse and OLAP. 

Getting Started This manual includes an overview of the 
MPM product and the standard interface 
features. 

MPM Globals This manual describes how to set up and 
manage your Global Sets in MPM, 
which are used in all your MPM 
projects. 

MPM Projects This manual describes how to set up and 
manage projects in MPM, define Work 
Breakdown Structures, establish 
baselines, track project milestones, 
replan projects, and report and analyze 
data. 

Online Help 
Complete online Help is available. You can open Help from the 
Help menu, by pressing F1, or by clicking on Help buttons in 
dialog boxes. 

Terminology 
In a field as complex as project management, there are many 
technical terms used. Unfortunately, terms are not standard 
across all organizations and companies. To familiarize yourself 
with the terminology adopted for the MPM product, you might 
want to take a few minutes to review the glossary in Appendix A 
of the MPM Projects manual. 
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Chapter 1: Introduction 2 

1.1  Overview 

This guide contains a sample of each standard report, worksheet, 
and turnaround document included in MPM. Each report section 
has a brief description of the report, its typical usage in a project 
management environment, and all its available conditioning 
options. Deltek is continuously adding to its selection of standard 
reports and welcomes recommendations and suggestions from 
our customers. 

MPM quickly and easily produces a wide variety of tabular and 
graphic standard reports specifically designed to meet 
government and in-house reporting needs. MPM’s flexible 
conditioning allows the user to easily customize almost any 
standard report to meet their specific requirements. Every report 
can be conditioned for a specific project area, internal 
organization, cost elements, time frame, etc.  

Government Reporting 
MPM includes a complete suite of reports designed to provide 
reporting required by government contracting regulations. These 
reports contain standard and recurring information. In addition, 
MPM provides a Cost of Money Override feature which allows 
users to override cumulative cost of money values as computed 
with MPM. 

In-House Reporting 
The worksheets and turnaround documents produced by MPM 
are convenient tools designed for gathering information in-house 
in an efficient way. These documents are generally used for 
gathering start-up information for new contracts, projects, or 
programs, in preparation for entering data into MPM. 

All reports, worksheets, and turnaround documents produced by 
MPM can be viewed on-screen as well. All time-phased reports 

display a minimum of 12 time units (12 months, 12 quarters, or 
12 years, depending on the timeframe of the report requested). 

Saving Report Conditioning 
MPM allows you to save conditioning and request batch 
processing of reports, which can be reused whenever a report is 
needed again.  

In addition, you can add formulated dates to the saved 
conditioning, so that when you reuse the criteria, today’s date (or 
an alternate date you provide) is substituted in the criteria.  

This eliminates the recreation of identical conditioning criteria, 
and allows you to create a set of monthly reports once that can 
be used over and over without duplicated effort. 

Report Viewer 
The Report Viewer in MPM allows you to view, change, 
redirect, export and summarize your MPM reports. The Viewer 
works much like a spreadsheet: the rows and columns contain 
the generated report data and headings.  

From the Viewer you can edit, reformat, and add calculations or 
graphics, reorganize, selectively display or save your report data.  

You can also export report data in the same powerful ways as 
with the Report Conditioning window. 
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Generating a Report 
For complete instructions on generating reports and using the 
Report Viewer, see Chapter 15: Reports in the MPM Projects 
manual. In general, follow these steps: 

1. Access the MPM Menu Manager and click the Reports 
tab. 

2. From the list of reports displayed, double-click the 
desired report.  

MPM displays the report’s conditioning window. 

3. On the conditioning window, indicate the desired project 
area, internal organization, data type, cost elements, time 
frame, etc.  

4. Choose the output destination. 

 

 

 

 

 

 

 

 

Printer 

Report Viewer 

UN/CEFACT (*.XML) for a UN/CEFACT 
standard XML file (CPR1 through CPR4 only). 

Comma-Separated Values (*.CSV)  for a text file 
with values separated by commas. 

Excel 95 (*.XLS) for an Excel spreadsheet in Excel 
95 format. 

Excel 97 – 2000 (*.XLS) for an Excel spreadsheet in 
Excel 97-2000 Format 

Tab-Separated Values (*.TXT) for a text file with 
values separated by tabs. 

HTML (*.HTM) for an HTML file which you can 
view in an Internet browser program like Netscape 
or Internet Explorer. 

 

5. (Optional) You can change the current date by clicking 

 Set Date, or by selecting Tools » Set Current Date. 

6. Click  Run. 

Note: Choosing Print on the File menu will only 
print your report options! 
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1.2  Available Reports 

Because MPM is so flexible, the conditioning options can 
produce numerous reports. Use the table below to find the 
desired report.  

1. Find the report you want in the first column of the table. 
All of MPM’s reports are described in detail in 
Chapter 2. 

2. On the MPM Menu Manager, double-click the icon for the 
report name listed in the second column of the table. 

3. In the report conditioning window, select the designated Data 
Type listed in the third column of the table.  

Report Description Report Name on icon Data Type  
Accounting Calendar Accounting Calendar n/a
Analyze Distributed Import Analyze Distributed Import n/a
Apportioned Estimates Relationships – Baseline 
Apportioned Estimates Relationships – ETC

Apportioned Estimates Baseline 
ETC

Resource Basis of Estimate 
Summary Basis of Estimate 

Basis of Estimate Resource 
Summary

Burden and Fee Detail – Baseline 
Burden and Fee Detail – ETC 
Burden and Fee Summary – Baseline 
Burden and Fee Summary – ETC 

Burden and Fee Detail - Baseline 
Detail - ETC 
Summary - Baseline 
Summary - ETC

CLIN/SOW/WBS CLIN/SOW/WBS n/a
CPR Format  1 CPR  1 n/a
CPR Format  2 CPR  2 n/a
CPR Format  3 CPR  3 n/a
CPR Format  4 CPR  4 n/a
C/SSR CSSR n/a
Compare Detail versus EOC Rollup 
Compare Detail versus Summary Rollup

Compare Detail and Rollup EOC Rollup 
Summary Rollup

CLIN Table Contract Line Items n/a
Control Account Plan Control Account Plan n/a
DD 1861 DD 1861 n/a
DD 1921 DD 1921 n/a
Detail Variance Analysis Detail Variance Analysis n/a
EAC Comparison EAC Comparison n/a
Actuals by EOC 
Actuals by Charge Number 
Element of Cost 
WBS Recap by EOC 
Budget/Actuals Recap by EOC 
Element of Cost/Class Detail   
Element of Cost/Class Detail – ETC 
Element of Cost – ETC 
Element of Cost – LRE 
S/P/A Tabular by EOC 
S/P/A Recap by Element of Cost 

Element of Cost Actuals by WBS 
Actuals by Charge Number 
Baseline 
Baseline – Recap 
Budget/Actuals – Recap 
EOC/Class – Baseline 
EOC/Class – ETC 
ETC 
LRE 
S/P/A Tabular  
S/P/A Recap



 

 
Report Description Report Name on icon Data Type  
EVM Planning & Analysis EVM Plan and Analysis n/a
Element of Cost/Class Element of Cost Table n/a
Labor/Price Summary by WBS 
Labor/Price Summary by CLIN 

Labor/Price Summary WBS  
CLIN

Program Log 
Management Reserve Log 
Undistributed Budget Log 

Logs Program Log 
Management Reserve Log 
Undistributed Budget Log

Manpower Detail 
Manpower Summary 

Manpower  Detail 
Summary

Milestone Barchart Milestone Barchart n/a
Milestone Status Turnaround Document Milestone Status Turnaround Document n/a
NASA533 M NASA 533 M n/a
NASA533 P NASA 533 P n/a
NASA 533 Q NASA 533 Q n/a
OBS Burden Templates OBS Burden Template N/a
OBS Indented OBS Indented n/a
Price/Usage Variance Analysis Price/Usage Variance Analysis n/a
Project Comparison Baseline 
Project Comparison LRE 
Project Comparison Timephased Baseline 
Project Comparison Timephased LRE

Project Comparison Baseline 
LRE 
Timephased Baseline 
Timephased LRE

Proposal Summary by WBS 
Proposal Summary by CLIN 

Proposal Summary WBS 
CLIN

Resource Detail 
Resource Detail – Actuals 
Resource Detail – ETC 
Resource Detail – Budget/LRE 
Resource Summary 
Resource Summary – Actuals 
Resource Summary – ETC 

Resource  Detail - Baseline 
Detail - Actuals  
Detail -ETC 
Detail - Budget/LRE  
Summary - Baseline 
Summary - Actuals 
Summary –ETC

Resource Department Summary Resource Department Summary n/a
Resources and Burdens Resources and Burdens n/a
Responsibility Assignment Responsibility Assignment n/a
Responsibility Assignment Matrix Responsibility Assignment Matrix n/a
SF 1411 SF 1411 n/a
Spread Curves Spread Curve n/a
Task Description Task Description n/a
Variance Analysis Turnaround Document Variance Analysis Turnaround Document n/a
WBS Hierarchy WBS Hierarchy n/a
WBS Indented WBS Indented n/a
Weekly - Performance 
Weekly - EOC Detail 
Weekly - EOC Rollup 

Weekly   
 

Performance 
EOC Detail 
EOC Rollup 

Work Authorization Document Work Authorization Document n/a
Work Status Document – EV 
Work Status Document – Budget/LRE

Work Status Document Earned Value 
Budget/LRE
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Report Timeframe Information: To change the 
timeframe to be reported, specify the Report From/Start 
dates or the Report Period From/Through dates. Dates can 
be entered in the usual formats, or as Formulated Dates. See 
below for instructions on using Formulated Dates. 

WBS Leg (optional): To report a particular WBS Leg, 
enter the WBS ID, or click the  button which is added to 
the WBS Leg criteria box when the box is clicked. MPM 
displays the WBS Leg dialog box. Highlight the desired 
leg, expanding the levels if necessary. The WBS ID 
selected is inserted in the Criteria box. 

WBS Level (optional): Enter a value from 1 through 99 to 
export WBS elements at the level entered.  

WBS fields: On most Project reports, you can specify a 
particular WBS Leg or Level to be included, or select a 
subset of data using the WBS fields Alias, Manager, Cross 
Reference, Element Type, Performing/Responsible OBS, 
CLIN. 

Type of Data: On most Project reports, you can choose to 
include Incremental, Cumulative, and/or At Complete 
values in the report. 

Level of Detail: You can choose to include data rolled up 
to the EOC, COC, or Resource level. You can also choose 
to include summary or detail data on some reports. 

 

 

 

 

 

 

 

 

 

In every Report Conditioning Window, the left pane of the window 
displays the icon(s) for the selected type of report, and the right 
pane displays the conditioning information about the report. The 
right pane is divided into two columns. The Filter column shows 
the report condition field to be specified, such as Project. The 
Criteria column contains the list boxes, checkmark boxes, or text 
entry boxes in which you enter the criteria for the condition. The 
rows are grouped into categories. Category headings are shown in 
gray for reference. When reporting MPM data, most reports 
contain these conditioning options: 

Global ID: (Changed indent on all following paragraphs to 
align with bullet text.) On all Global reports, select the 
Global File containing the data to be reported. 

You use the Report Conditioning window to select the content and 
format for a specific report. A toolbar gives you quick access to 
common tasks. The Report Conditions Grid displays the 
information about the report. 

Each report has a window which contains the conditioning options 
that modify the report. Every available conditioning option for the 
specified type of report is shown. 

You open the Report Conditioning Windows by clicking the 
Reports tab on the MPM Menu Manager. When you access the 
Reports tab, all reports to which you have been granted access are 
listed. Double-click the desired report icon. 

Project ID: On all Project reports, select the Project 
containing the data to be reported. 

Accessing the Report Conditioning Windows 

1.3  Report Conditioning 

Report Conditions Grid 
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 Additional Data: You can add information to some reports 
such as Task Descriptions, BOEs, Milestones, Performance 
Summaries, Financials, Recap, and many other special 
processing options. Some are unique to the report you 
requested.  

Sorting the Output 
You can sort your report in a variety of ways. You can apply a 
primary sort and if desired, a secondary sort.  
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1.3  Report Conditioning 

1.3.1  Using Formulated Dates 
In all Report Conditioning options that require a date, instead of 
entering an actual date, you can enter a date formula. A date 
formula is a calculation based on the current date. If you have a 
standard set of reports that are run every month, using this feature 
will save you a lot of time, because you can reuse the report 
conditioning without modifying it for the current period. 

The current accounting period is substituted in any report 
conditioning criteria when you enter =<CURRENT>, based on your 
system date or the date you enter in Set Current Date on the Tools 
menu. To substitute other dates, modify the date formula by adding 
or subtracting d)ays, w)eeks, m)onths, or y)ears. 

When filling conditioning options that require a date (for example, 
17-JUL-97), you can use d)ays or y)ears in your formula. For 
example, if today is July 17th, 1997: 

=<CURRENT> + 3y  would be calculated as July 17th, 2000 
=<CURRENT> + 60d would be calculated as Sept 15th, 1997  

When filling conditioning options that require a period (for 
example, JUL-97), you can use m)onths or p)eriods in your 
formula. For example, if the current period is JUL-97: 

=<CURRENT> + 3p would be calculated as OCT-97 
=<CURRENT> - 2m would be calculated as MAY-97 

Once you enter a formulated date and move to another field on the 
Report Conditioning window, the date is calculated based on the 
current date and displayed in brackets next to the formula in the 
Criteria box. The Gate Month entered is 3 fiscal months after the 
current month. 

Using formulated dates is extremely valuable when you save report 
conditioning for later batch processing, especially when a Batch 

Report file contains multiple reports. Each time you run the same 
report(s), the dates will be recalculated based on the current date 
without you having to re-enter the new dates.  

To ensure the formulated dates are calculated correctly, check to 
see that the Current Date is set correctly before running the report. 
You can check the date either in the system date or using Set 
Current Date. 

You cannot use formulated dates on Headers. 
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1.4  Creating Government-Required Reports 

 MPM provides a standard set of reports which can be used for 
reporting your project to U.S. government agencies in prescribed 
formats. These reports include data which is outside of MPM, 
including headers, variances, and Cost of Money overrides. For 
instructions on entering this data, see topic 1.4.1  Entering 
Government Report Data. 

CPR Reports for DoD/DoE Reporting 
The CPR reports are used primarily for reporting cost and schedule 
progress to the government or government contractors on specific 
procurements. There are four CPR reports, each of which can be 
printed in three formats. The 1989 format report complies with 
OMB No. 22R0327. The 1995 format report complies with OMB 
No. 0704-0188 and DID No. DI-MGMT-81466. The 2005 format 
report complies with DID No. DI-MGMT-81466A.  Please refer to 
your contractual reporting requirements for the appropriate use and 
application of the various versions of the CPR. 

 

 

 

 

CPR1 – Cost Performance Functional Categories 
Report in three formats 
This report includes current period, cumulative, and At 
complete values for each WBS element, and contains header 
data showing quantity, targets, ceilings, and MEAC 
calculations. This report also contains computed and 
overridden data about budget, price, Management Reserve 
(MR), Undistributed Budget (UB), and MEAC cases.  
CPR2 – Cost Performance Organizational Categories 
Report in three formats 
This report includes current period, cumulative, and At 
complete values for each Organization (Performing or 
Responsible), and contains header data showing quantity, 

targets, ceilings, and MEAC cases. This report also contains 
computed and overridden data about budget, price, 
Management Reserve (MR), Undistributed Budget (UB), 
and MEAC cases.  

CPR3 – Cost Performance Baseline Report in three 
formats 
This report displays a forecast of monthly changes to the 
Baseline, Management Reserve, and Undistributed Budget 
for the entire project, and contains header data showing 
schedule dates for the contract and the project.  

CPR4 – Cost Performance Manpower Loading Report in 
three formats 
This report displays a forecast of hours and person-months 
by organization (Performing/Responsible), and contains 
header data showing schedule dates for the contract and the 
project. 

C/SSR Reports for DoD/DoE Reporting 
The C/SSR (Cost/Schedule Summary) report is used primarily for 
reporting cost and schedule summary data to the government or 
contractors on specific procurements. This report can be printed in 
either of two formats. The 1989 OMB format report complies with 
OMB No. 22R0327. The 1995 DID report complies with OMB 
No. 0704-0188 and DID No. DI-MGMT-81466. Please refer to 
your contractual reporting requirements for the appropriate use and 
application of the various versions of the C/SSR. 

 

This report includes cumulative and At complete summaries for 
each WBS element, and contains header data showing contractor 
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and contract information, and MEAC calculations. This report also 
contains computed and override data about contract price, budget, 
Management Reserve (MR), Undistributed Budget (UB), and 
MEAC cases. 

Reports for NASA Reporting 
The NASA reports are used primarily for reporting contractor 
financial management to NASA. MPM offers three NASA 533 
formats: 533-M (Monthly), 533-Q (Quarterly), and 533-P 
(Monthly Performance Analysis).  Definitions and instructions for 
these reports can be found in the NASA publication NHB 9501.2b.  

These reports include cumulative and ETC summaries for each 
WBS element, and contain header data showing contract 
information and billing data. You can also select detail increments 
by month, quarter, or year.  

Contract Proposal Reports for DoD Reporting 
The SF1411 (Contract Pricing Proposal Cover Sheet) report is used 
by DoD contractors for providing all required information for your 
proposal, sorted by CLIN (Contract Line Item). 

The DD1921 (Cost Data Summary) report is used by DoD 
contractors for reporting cost data summaries for providing all 
required information for your proposal, sorted by CLIN (Contract 
Line Item) in OMB format. This report has header data showing 
contract price, ceiling, type, fiscal year funding, and contractor 
data. 

The DD1861 (Contract Facilities Capital and COM) report is used 
by DoD contracts for reporting methods of allocation of contractor 
facilities costs. This report is available as a monthly or yearly 
report, and has header data showing Treasury rate, proposal, and 
contract data. 

 

 

 



 

1.4  Creating Government-Required Reports 

1.4.1  Entering Government Report Data 
The MPM government-required reports contain data which is not 
tracked by MPM. You must enter these values separately. You can 
enter values for the Header, Variance, and COM data on the 
Report Conditioning windows. To set up government-required 
reports, follow these steps: 

1. On the Menu Manager with the Reports tab showing, 
double-click the desired report. In Figure A, the DD1861 
report is selected. 

 
Figure A. Select the desired government report 

MPM displays the Report Conditioning window for the 
report you selected. 

2. Click the  icon next to the Project drop-down list box. 

MPM displays the Header dialog. All necessary values for 
the selected report are shown.  

To enter headers/thresholds, click here

 
Figure B. Inside the Report Conditioning window. 

 
Figure C. Enter Headers for DD1861 report. 
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3. Enter the Header, Variance and any other data necessary 
for this government report. The drop-down list box at the 
top shows the selected report.  

You can also enter these values on the Project Maintenance 
window, where they are saved with the project. You can then use 
those values repeatedly on multiple reports. The values appear as 
the default when requesting reports that use them. To enter these 
values from the Project Maintenance window, select Tools | 
Headers. MPM displays the Header dialog as shown in Figure C, 
with the first report in the list selected. 
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1.5  Report Execution 

When you have decided which report you want and have 
selected the data to be included through the conditioning process, 
the final step is the execution of the report. To ensure the report 
contains the information desired, you should be aware of the 
methodology used by MPM to select data for a report. 

Methodology for Determining Report Content 
As estimate data for a project is entered, MPM stores the 
information in a detail record that contains all the information for 
that estimate. Then, when an estimate is stored, MPM 
automatically builds the rollup record, if the Rollup Processing 
Toggle is in the On Mode. The rollup record summarizes each 
element by EOC (rollup from children). The data in the rollup 
record is rolled up through the WBS hierarchy. 

To generate a requested report, MPM uses either the EOC 
records or the Summary rollup records to gather the information 
to produce the selected report. 

Cost Reports Generated from the Detail Records 
If the report selected requires data from the detail record, rollup 
information is not reported, only detailed estimate data. For this 
reason, a request for a report at Level 2 of the WBS would 
produce an empty report if no estimates exist at that level. 

Data selection is applied only against those data elements stored 
while estimating the WBS, such as department.  

For example, assume no Performing for Responsible Department 
was specified for a WBS when the WBS tree was created, but a 
Resource Department was specified while entering an estimate. 
Selection by Resource Department ID selects on Resource 
Department, not WBS Department, and this causes the estimate 
to be included in your report. 

All versions of the following reports (Baseline, Actuals, and 
ETC) are generated from detail records: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Apportion Estimate Relationships 
Apportion Estimate Relationships – ETC 
Basis of Estimate (Turnaround Document) 
DD1861 
DD1921 
EOC/Class Detail Burden and Fee Detail 
EVM Planning & Analysis 
Manpower Detail 
Manpower Summary 
Resource Detail 
Resource Summary 
Resource Graph Burden and Fee Summary 
Resource Detail – Budget/LRE 

If the report you select uses data derived from the EOC rollup 
record, only rollup data is reported. Detail information is not 
reported. For this reason, a request for a report at Level 2 of the 
WBS would produce rollup data for each Level 2 element 
regardless of the level at which estimates were entered. 

Data selection is applied only against data elements stored within 
the rollup records. The records contain data rollup up by WBS 
element and store the element of cost and monthly information. 
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For example, assume no Performing or Responsible Department 
was specified for a WBS when the WBS tree was created by a 
Resource Department was specified while entering an estimate. 
Selection by Performing or Responsible Department ID selects 
on the WBS Department, not the Resource Department. 
Therefore, no values will be reported. 

However, if the Performing or Responsible Department ID was 
identified on the WBS tree, selection by that Department ID 
would cause the rollup values for that WBS to appear on the 
report. 

The following reports are generated from the EOC rollup 
records: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Actuals by Charge Number 
Actuals by EOC 
All Analysis Reports (except EVM Planning & Analysis) 
All Element of Cost Reports (except EOC/Class Detail) 
All Recap reports 
CLIN/SOW/WBS 
EAC Comparison 
Project Comparison – Baseline 
Project Comparison – LRE 
Resource Department Summary 
Responsibility Assignment Matrix 
SF 1411 
Summary Basis of Estimate 
Variance Analysis Turnaround Document 
Work Authorization Document 
Work Status Documents 

Cost Report Generated from the Summary Rollup 
Record 
The following reports are generated from the Summary Rollup 
Records: 

Labor/Price Summary by WBS 
Labor/Price Summary by CLIN 
Proposal Summary Report by WBS 
Proposal Summary Report by CLIN 
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1.6  Helpful Hints for Report Debugging 

If you suspect that values on a report might be in error, follow 
these steps to try to determine the problem: 

1. Determine whether the report is generated from the detail, 
EOC, or summary data. 

If generated from detail records: 

 

 

 

 

 

 

 

Go to the source of input. For example, if a resource 
value seems incorrect, check the resource against the 
WBS in the Integrated Planning task window. 

If generated from EOC records: 

If the incorrect values are Actuals, use the Rebuild 
Rollup utility on the Project Maintenance window to 
rebuild Actual rollups. 
If the incorrect values are baseline or ETC estimates, 
use the Rebuild Rollup utility to rebuild estimate 
rollups. 
If the incorrect value is BCWP, recalculate BCWP 
through the correct month. 

If generated from summary records: 

Select View Toggle Status on the View menu, and 
verify that the Summary Rollup Toggle is ON. If not, 
access the Project Maintenance window and set it ON, 
which will rebuild the Summary Rollup records from 
the detail records. 
Run the Compare Detail and Rollup report. If there is a 
difference between the detail and summary records, it 
will be necessary to rebuild rollup estimates using the 
Rebuild Rollup utility on the Project Maintenance 
window. 

2. Check the Current date, either in the system date or by 
using Set Current Date, especially if you are using 
formulated dates. All reports are designed to give 
information up to and including the month which includes 
the Current Date. If your report produces no data for the 
month you want, recheck the Current Date.  

3. If you have chosen to calculate LRE on the CPR reports 
using Option A (LRE = ACWP through the reporting 
month + ETC to the end of the project) and would like to 
verify the LRE calculation, run an Actuals report up to and 
including the CPR reporting month. Next, run an ETC 
report from the next month through the end of the project. 
If for example the CPR report date is JAN 98: 

a. Run an Actuals report up to January 1998, and note the 
total. 

b. Run an ETC report (from report start, not inception) 
for February 1998 through the end of the project, and 
note the total. 

c. The sum of these two values should equal the LRE 
value. 

Other Report-Specific Hints 
The CPR Format 2 Report is generated based on the OBS 
assignments on the WBS tree. If the numbers on this report 
seem understated, recheck the OBS assignments on the 
WBS tree. If an OBS assignment was left off, the WBS 
values will not be included in the report. 
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The CLIN/SOW/WBS Report is generated based on the 
CLIN assignments made on the WBS tree. If the numbers 
on this report seem understated, check the CLIN 
assignments on the WBS tree. If a CLIN assignment was 
left off, then that WBS element’s values will not be 
included in the report. 

 

 

 

Computed Header values that appear in the computed 
columns on the Header Values screen come from the 
Program Log. If the numbers seem to be in error, recheck 
the Program Log area. If the erroneous number is an Actual 
value, recheck the number against an Actuals report. If the 
erroneous number is an LRE value, recheck the LRE 
calculation using the method outlined above. 
If an EOC report seems to be understated, check the 
Element of Cost Table in the Globals and make sure no 
EOCs have been deleted. Element of Cost reports will not 
report values if the EOC is not in the table. 
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2.1  Accounting Calendar Report 

The Accounting Calendar report is a tabular report of your 
calendar, which lists start dates for accounting months, equivalent 
person month hours in each month, and all holidays. You use the 
Calendar report to check fiscal periods and date scheduling. 

Conditioning Window 
Access the Accounting Calendar Report Conditioning Window by 
selecting Accounting Calendar on the Reports tab.  

The Accounting Calendar report has no additional options beyond 
the standard options available on all Report Conditioning 
windows.  

Report Source 
This report uses the CALENDAR.FSC (the fiscal calendar) and 
CALENDAR.HOL (the holiday calendar) databases.  
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2.2  Analyze Distributed Import File Report 

The Analyze Distributed Import File report is an analysis report of 
your Distributed Import file, which you generate in the Distributed 
Project Export window (see the Projects manual Chapter 17: 
Exporting Data for details). You use the Analyze Distributed 
Import File report to check the export file of your subproject you 
create, before you run the import to your superproject. This 
analysis report will detect any potential problems with the data. 

Conditioning Window 
Access the Analyze Distributed Import File Conditioning Window 
by selecting Analyze Distributed Import File on the Reports tab.  

Required Entries 
The Analyze Distributed Import File Report has options for 
identifying the subproject and the superproject (for comparison 
with the file), and output options for sending the results of the 
analysis to different destinations. 

To generate this report, you must identify the subproject (Source 
Project) from those listed in the drop-down list box, and the 
superproject (Target Project) from those listed. You also must 
identify the name of the Import File to be analyzed (Transfer File 
Name).  

 



Chapter 2: Report Descriptions and Examples 26 

 

 



 MPM Standard Reports    27 

2.3  Apportioned Estimates Reports 

The Apportioned Estimates icon provides two tabular reports: 
Baseline Apportioned Estimates and ETC Apportioned Estimates. 
These reports show base estimates, the apportioned estimates 
created from them and the percentile relationship of each 
apportionment to the base estimate.  

Conditioning Window 
Access the Apportioned Estimates Report Conditioning Window 
by selecting Apportioned Estimates on the Reports tab. 

Report Types Available 
 Baseline displays all baseline Apportioned Estimates 

designated as base estimates. 
 ETC displays all ETC Apportioned Estimates designated as 

base estimates. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameZ.APP. 
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2.3.1  Baseline Apportioned Estimates Report 

  

 



 2.3.2  ETC Apportioned Estimates Report 
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2.4  Basis of Estimate Reports 

The Basis of Estimate report shows the narrative basis of estimate 
for justification requirements of government proposals. Basis of 
Estimate is included in the Cost Volume of proposals. 

Conditioning Window 
Access the Basis of Estimate Report Conditioning Window by 
selecting Basis of Estimate on the Reports tab. 

Report Types Available 
 Resource Basis of Estimates 
 Summary Basis of Estimates 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 

 OBS performing/responsible departments, a specific 
department, a specific CLIN 

 specific EOC codes (Summary BOE report only) 
 specific BOE Resource Departments included in Summary 

BOE estimates (enter * to include all departments) 

Data Inclusion Options 
You can also choose to include in the report: 

 Task Descriptions 
 BOE text 
 Approval/page breaks 

Report Source 
This report uses the files projectnameE.BOE, projectnameD.WTD, 
projectnameU.RRH, and projectnameW.RRD. 



2.4.1  Resource BOE Report 
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2.4.2  Summary BOE Report 
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2.5  Burden and Fee Reports 

The Burden and Fee report provides four tabular reports: Burden 
and Fee Baseline Detail, ETC Detail, Baseline Summary, and ETC 
Summary. These reports show the total dollar values for each 
burden and fee category (G&A, overhead, etc.). The Baseline 
Burden and Fee reports may be included in Proposal Cost Volume. 

Conditioning Window 
Access the Burden and Fee Report Conditioning Window by 
selecting Burden and Fee on the Reports tab. 

Report Types Available 
 Detail Baseline shows total dollar values for each baseline 

burden/fee category. 
 Detail ETC shows total dollar values for each ETC burden 

category. 
 Summary Baseline shows summary dollar values for each 

baseline burden/fee category. 
 Summary ETC shows summary dollar values for each ETC 

burden category. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 

 specific WBS Aliases, Managers, Cross-References, 
recurring/nonrecurring items 

 OBS performing/responsible departments, a specific 
department, a specific CLIN 

 specific EOC codes 

Data Inclusion Options 
You can also choose to include in the report: 

 incremental values 
 cumulative values 
 G&A 
 Overhead  
 COM 
 Fee 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe).  

Report Source 
This report uses the files projectnameE.BOE, projectnameD.WTD, 
projectnameU.RRH, and projectnameW.RRD. 
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2.5.1  Detail-Baseline Burden and Fee Report 

 

 



2.5.2  Summary-Baseline Burden and Fee Report 
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2.5.3  Detail-ETC Burden and Fee Report 

  

 



2.5.4  Summary-ETC Burden and Fee Report 
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2.6  CLIN/SOW/WBS Report 

The CLIN/SOW/WBS report is a compliance matrix used to 
verify pricing of all Contract Line Item Numbers (CLIN) and 
Statement of Work (SOW) items, and shows applicable WBS 
total labor hours, total cost, total price, and subtotals, sorted by 
CLIN. 

This report will only show Statement of Work items if you 
relabel one of the Cross-reference fields SOW on the 
Project Maintenance window, and enter the appropriate 
SOW number on WBS elements when building the WBS 
Tree.  

Conditioning Window 
Access the CLIN/SOW/WBS Report Conditioning Window by 
selecting CLIN/SOW/WBS on the Reports tab. 

The CLIN/SOW/WBS report has no additional options beyond 
the standard options available on all Report Conditioning 
windows.  

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD. 
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2.7  CPR Format 1 Reports 

The CPR1 icon provides the Cost Performance – Work Breakdown 
Structure Report, which is used in all levels of project management 
by government contractors and complies with DoD 5000.2 
requirements.  

The CPR1 report is available in three formats:  

 The 1989 format report complies with OMB No. 22R0327.  

 The 1995 format report complies with OMB No. 0704-
0188 and DID No. DI-MGMT-81466.  

 The 2005 format report complies with DID No. DI-
MGMT-81466A.   

Please refer to your contractual reporting requirements for the 
appropriate use and application of the various versions of the CPR. 

 

Undistributed Budget and Management Reserve values are 
derived from the Program Log, unless overridden in the 
Header information. 

Conditioning Window 
Access the CPR1 Report Conditioning Window by selecting CPR1 
on the Reports tab.  

Headers 
You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box. This report includes header data 
showing quantity, targets, ceilings, and MEAC cases, and 
computed data about budget, price, Management Reserve (MR), 
Undistributed Budget (UB), and MEAC cases which can be 
overridden.  

Report Formats Available 
Choose the 1989, 1995, or 2005 report format from the Report 
Format drop-down list. 

Data Selection Options 
You can limit the report to include only a specific WBS leg.  

Data Inclusion Options 
You can choose to include: 

 WBS elements with no values (because they have no 
estimates) 

 Elements of Cost 
 Variance Reconciliation 

Data Calculation Options 
You can choose to calculate LRE values using your choice of these 
formulas: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 
 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 BAC 
 BAC / CPI 2 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 
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Data Formatting Options 
 You can display dollars in Whole Numbers, Thousands, or 

Decimal Thousands. 
 Where the report displays the WBS ID, you can choose to 

identify WBS by Alias or Cross-Reference-1 instead. 

Report Source 
This report uses the files projectnameU.RRH, 
projectnameW.RRD, projectnameQ.LOG, and 
projectnameT.HED. 
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2.7.1  CPR Format 1 and 2 Report Header Data 
Using the CPR Format 1 and 2 header function, you can define 
and store project information that appears on all CPR Format 1 
and 2 reports prepared for your project. The details of entering 
the header data are given below. 

General Text 
Enter the text for the following fields in the same way you would 
on a printed form. 

 Contractor  Security Class 
 Location 2  Number 
 Contract Name  Phase 
 Program Name  Phase (2005 Format)2 
 Contract Number  EVMS Acceptance 
 Approval Authority  EVMS Acceptance Date 
 Title  Gen and Admin 
 Type1  

1 If exporting report via UN/CEFACT format the Type field in Headers 
must be one of the following 3 letter entries: 

‘TCA’ = Cost plus incentive fee 
‘TCH’ = Cost sharing 
‘TCS’ = Cost 
‘TCW’ = Cost plus award fee 
‘TCX’ = Cost plus fixed fee 
‘TFB’ = Fixed price incentive, firm target, with performance incentives 
‘TFC’ = Fixed price incentive, firm target, without performance incentives 
‘TFD’ = Fixed price redetermination prospective 
‘TFF’ = Fixed price incentive, successive targets, with performance incentives 
‘TFG’ = Fixed price incentive, successive targets, without performance 

incentives 
‘TFH’ = Fixed price award fee 
‘TFJ’ = Fixed price level of effort 
‘TFK’ = No cost 
‘TFM’ = Fixed price redetermination retroactive 
‘TFR’ = Firm fixed price 
‘TFX’ = Fixed price with economic price adjustment 
‘TLH’ = Labor hours 
‘TTM’ = Time and materials 

2 If exporting report via UN/CEFACT format the Phase (2005 Format) 
field in Headers must be one of the following 3 letter entries: 

‘DEP’ = Deployment 
‘FRP’ = Full rate production 
‘LRP’ = Low rate initial production 
‘OS’ = Operations and support 
‘PRC’ = Government procurement 
‘PRD’ = Production 
‘RDT’ = Research, development. Test and evaluation 
‘SDD’ = System development and demonstration 
‘ZZZ’ = Mutually defined 

Gen and Admin 
If you select Add, the Current Period, Cumulative to Date, 
Reprogramming Adjustments, and the At Completion values on 
the CPR do not include G&A. G&A is displayed as a separate 
item, and the values displayed for G&A are added when MPM 
calculates the Totals at the bottom of the CPR. 

If you select Non-Add, the Performance Data values include 
G&A. G&A is displayed as a separate item, and the values 
displayed for G&A are not added in again when MPM calculates 
the Totals at the bottom of the CPR. 

Header Value Column 
The data for the Header Value column is entered by you. The 
information is taken from the contract. 

Computed Columns 
The Computed column does not contain data entry fields. The 
values shown in this column are computed by MPM. MPM 
derives the values for Negotiated Cost, Authorized Unpriced, 
Management Reserve, and Undistributed Budget from data 
stored in the Program Log. Any modifications that are made to 
log values will affect the Computed Column values. 

The following formulas are used to calculate values: 
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Target Profit Amount = Target Profit % X Negotiated Cost 

Est. Price = Neg. Cost + Authorized Unpriced X (1 + 
(Tgt Profit % / 100)) 

Target Price = Neg. Cost + Target Profit Amount 

For all CPRs: 

Negotiated Contract Change = All log entries 

For the C/SSR: 

Original Contract Target = Log Entry #1 
Negotiated Contract Change = All subsequent log entries 

Current Target Cost = Total of Log Entry #1 and all 
subsequent entries 

Value Columns 
The Value columns are also computed by MPM and are derived 
from data stored in the Program Log. Any modifications made to 
the log values will affect the Values column values. 

You can enter override values in any or all of the fields in the 
Value column. The override values affect only the CPRs and 
C/SSR. The values previously established and stored in the 
project will not be affected. 

With the exception of the Negotiated Contract Change value, any 
changes in override values to the C/SSR will also be reflected in 
all other CPRs and the C/SSR, and vice versa. 

If you wish to override the Negotiated Cost value, you must 
make the change on both the CPR and the C/SSR. The reason for 
this is that the Negotiated Contract Cost field on the C/SSR and 
the CPRs do not contain the same information. The Current 
Target Cost field on the C/SSR equates to the Negotiated 
Contract Cost field on CPRs. 
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2.7.2  CPR1 Report – 1989 Format
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2.7.3  CPR1 Report – 1995 Format
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2.7.4  CPR1 Report – 2005 Format 
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2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 

You can choose to calculate LRE values using you choice of these 
formulas: 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

 WBS elements with no values (because they have no 
estimates) 

Choose whether to include Performing or Responsible OBS 
departments. 

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 

Data Calculation Options 

 Variance Reconciliation  

Data Selection Options 

Data Inclusion Options 

 Cum ACWP + ETC 

You can choose to include: 

 Elements of Cost 

 BAC / CPI 2 
 BAC 

 The 1989 format report complies with OMB No. 22R0327.  

Please refer to your contractual reporting requirements for the 
appropriate use and application of the various versions of the CPR.  

Access the CPR2 Report Conditioning Window by selecting CPR2 
on the Reports tab.  

You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box. This report includes header data 
showing quantity, targets, ceilings, and MEAC cases, and 
computed data about budget, price, Management Reserve (MR), 
Undistributed Budget (UB), and MEAC cases which can be 
overridden. For details information on entering Header data, see 
topic 2.7.1  CPR Format 1 and 2 Report Header Data. 

The CPR2 icon provides the Cost Performance – Functional 
Categories Report, which is used in all levels of project 
management by government contractors and complies with DoD 
5000.2 requirements.  

 The 1995 format report complies with OMB No. 0704-
0188 and DID No. DI-MGMT-81466.  

Choose the 1989, 1995, or 2005 report format from the Report 
Format drop-down list. 

This report automatically accumulates totals to Level 2 of the 
selected OBS structure. 

 The 2005 format report complies with DID No. DI-
MGMT-81466A.   

The CPR2 report is available in three formats:  

2.8  CPR Format 2 Reports 

Report Formats Available 

Conditioning Window 

Headers 
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Data Formatting Options 
 You can display dollars in Whole Numbers, Thousands, or 

Decimal Thousands. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD. 
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2.8.1  CPR2 Report – 1989 Format 

  

 



 

 MPM Standard Reports    53 



Chapter 2: Report Descriptions and Examples 54 

2.8.2  CPR2 Report – 1995 Format 
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2.8.3  CPR2 Report – 2005 Format 
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2.9  CPR Format 3 Reports  
The CPR3 icon provides the Cost Performance – Baseline Report, 
which is used in all levels of project management by government 
contractors and complies with DoD 5000.2 requirements.  

The CPR3 report is available in three formats:  

 The 1989 format report complies with OMB No. 22R0327.  

 The 1995 format report complies with OMB No. 0704-
0188 and DID No. DI-MGMT-81466.  

 The 2005 format report complies with DID No. DI-
MGMT-81466A.   

Please refer to your contractual reporting requirements for the 
appropriate use and application of the various versions of the CPR.  

Conditioning Window 
Access the CPR3 Report Conditioning Window by selecting CPR3 
on the Reports tab.  

Headers 
You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box. This report includes header data 
showing schedule dates for the contract and the project.  

Report Formats Available 
Choose the 1989, 1995, or 2005 report format from the Report 
Format drop-down list. 

Data Processing Options 
You can choose to Store Baseline Data once you are certain the 
data on the report is correct. Once you have stored the values for a 
particular month, you cannot report on a previous month. If you 
choose to skip a month between reports, the values for the skipped 
month(s) are added to the cumulative-to-date column. A month 
should be skipped only if no baseline changes occurred during the 
month. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD.
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2.9.1  CPR Format 3 Report Header Data 
Using the CPR Format 3 header function, you can define and 
store project information that appears on all CPR Format 3 
reports prepared for your project. The details of entering the 
header data are given below. 

General Text 
Enter the text for the following fields in the same way you would 
on a printed form. 

 Contractor  EVMS Acceptance 
 Location 2  EVMS Acceptance Date 
 Contract Name  Contract Start Date 
 Program Name  Contract Definition Date 
 Contract Number  Last Item Completion Date 
 Type1  Planned Completion Date 
 Number  Contract Completion Date 
 Phase  Estimated Completion Date 
 Phase (2005 Format)2  

1 If exporting report via UN/CEFACT format the Type field in Headers 
must be one of the following 3 letter entries: 

‘TCA’ = Cost plus incentive fee 
‘TCH’ = Cost sharing 
‘TCS’ = Cost 
‘TCW’ = Cost plus award fee 
‘TCX’ = Cost plus fixed fee 
‘TFB’ = Fixed price incentive, firm target, with performance incentives 
‘TFC’ = Fixed price incentive, firm target, without performance incentives 
‘TFD’ = Fixed price redetermination prospective 
‘TFF’ = Fixed price incentive, successive targets, with performance incentives 
‘TFG’ = Fixed price incentive, successive targets, without performance 

incentives 
‘TFH’ = Fixed price award fee 
‘TFJ’ = Fixed price level of effort 
‘TFK’ = No cost 
‘TFM’ = Fixed price redetermination retroactive 
‘TFR’ = Firm fixed price 
‘TFX’ = Fixed price with economic price adjustment 
‘TLH’ = Labor hours 
‘TTM’ = Time and materials 

2 If exporting report via UN/CEFACT format the Phase (2005 Format) 
field in Headers must be one of the following 3 letter entries: 

‘DEP’ = Deployment 
‘FRP’ = Full rate production 
‘LRP’ = Low rate initial production 
‘OS’ = Operations and support 
‘PRC’ = Government procurement 
‘PRD’ = Production 
‘RDT’ = Research, development. Test and evaluation 
‘SDD’ = System development and demonstration 
‘ZZZ’ = Mutually defined 

Report Period 
On CPR Format 3 reports, the report periods are monthly for the 
first six months. For the next five reporting periods, you may 
select the increment from the following options: 

 

 

 

 

Month 
Quarter 
Semi-Annual 
Year 

Each reporting period can have a different increment. You enter 
the increments in the Report Period Column (10) through (14). 

Computed Columns 
The Computed column does not contain data entry fields. The 
values shown in this column are computed by MPM. MPM 
derives the values for Negotiated Cost and Authorized Unpriced 
from data stored in the Program Log. Any modifications that are 
made to log values will affect the Computed Column values. 

The following formulas are used to calculate values: 

Current Target Cost = Original Contact Target + Negotiated 
Contract Change 

Contract Budget Base = Current Target Cost + Authorized 
Unpriced 
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 Total Allocated Budget = Total Distributed and 
Undistributed Budget 

For all CPRs: 

Negotiated Contract Change = All log entries 

For the C/SSR: 

Original Contract Target = Log Entry #1 

Negotiated Contract Change = All subsequent log entries 

Current Target Cost = Total of Log Entry #1 and all 
subsequent entries 

Value Columns 
The Value columns are also computed by MPM and are derived 
from data stored in the Program Log. Any modifications made to 
the log values will affect the Values column values. 

Management Reserve Monthly Amount 
To enter the management reserve monthly amount, do one of the 
following: 

Enter in the Management Reserve Monthly Amount field 
the total amount of all management reserve transactions 
during the reporting period that is to be reported on 
Format 3. 
Identify the Log Entry numbers for itemization of 
individual transactions on Format 3. Enter the numbers in 
the Management Reserve Log 1 – 10 fields. 

Baseline Change Monthly Amount 
To enter the baseline change monthly amount, due one of the 
following: 

Enter in the Baseline Change Monthly Amount field the 
total amount of all management reserve transactions 
during the reporting period that is to be reported on 
Format 3. 

Identify the Log Entry numbers for itemization of 
individual transactions on Format 3. Enter the numbers in 
the Baseline Change Log 1 – 10 fields. 

 



 MPM Standard Reports    61 

  

2.9.2  CPR3 Report – 1989 Format
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2.9.3  CPR3 Report – 1995 Format

  

 



2.9.4  CPR3 Report – 2005 Format 
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2.10  CPR Format 4 Reports 

The CPR4 icon provides the Cost Performance – Manpower 
Loading Report, which is used in all levels of project management 
by government contractors and complies with DoD 5000.2 
requirements.  

The CPR4 report is available in three formats:  

 The 1989 format report complies with OMB No. 22R0327.  

 The 1995 format report complies with OMB No. 0704-
0188 and DID No. DI-MGMT-81466.  

 The 2005 format report complies with DID No. DI-
MGMT-81466A.   

Please refer to your contractual reporting requirements for the 
appropriate use and application of the various versions of the CPR.  

Conditioning Window 
Access the CPR4 Report Conditioning Window by selecting CPR4 
on the Reports tab.  

Headers 
You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box showing schedule dates for the 
contract and the project. This report also contains program 
variance thresholds for month, cumulative, and at-complete 
percents and values. 

General Text. Enter the text for the following fields in the same 
way you would on a printed form. 

 Contractor  Number 
 Location 2  Phase 
 Contract Name  Phase (2005 Format)2 
 Program Name  EVMS Acceptance 
 Contract Number  EVMS Acceptance Date 
 Type1  

1 If exporting report via UN/CEFACT format the Type field in Headers 
must be one of the following 3 letter entries: 

‘TCA’ = Cost plus incentive fee 
‘TCH’ = Cost sharing 
‘TCS’ = Cost 
‘TCW’ = Cost plus award fee 
‘TCX’ = Cost plus fixed fee 
‘TFB’ = Fixed price incentive, firm target, with performance incentives 
‘TFC’ = Fixed price incentive, firm target, without performance incentives 
‘TFD’ = Fixed price redetermination prospective 
‘TFF’ = Fixed price incentive, successive targets, with performance incentives 

2 If exporting report via UN/CEFACT format the Phase (2005 Format) 
field in Headers must be one of the following 3 letter entries: 

‘TFG’ = Fixed price incentive, successive targets, without performance 
incentives 

‘TFH’ = Fixed price award fee 
‘TFJ’ = Fixed price level of effort 
‘TFK’ = No cost 
‘TFM’ = Fixed price redetermination retroactive 
‘TFR’ = Firm fixed price 
‘TFX’ = Fixed price with economic price adjustment 
‘TLH’ = Labor hours 
‘TTM’ = Time and materials 

‘DEP’ = Deployment 
‘FRP’ = Full rate production 
‘LRP’ = Low rate initial production 
‘OS’ = Operations and support 
‘PRC’ = Government procurement 
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‘PRD’ = Production 
‘RDT’ = Research, development. Test and evaluation 

‘SDD’ = System development and demonstration 
‘ZZZ’ = Mutually defined 

Report Period. On CPR Format 4 reports, the report periods are 
monthly for the first six months. For the next five reporting 
periods, you may select the increment from the following options: 

 

 

 

 

Month 
Quarter 
Semi-Annual 
Year 

Each reporting period can have a different increment. You enter 
the increments in the Report Period Column (10) through (14). 

Report Formats Available 
Choose the 1989, 1995, or 2005 report format from the Report 
Format drop-down list. 

Data Selection Options 
Choose whether to include Performing or Responsible OBS 
departments. 

Data Inclusion Options 
You can choose to include WBS elements with no values. 

Data Processing Options 
To calculate Manpower (person-months) in this report, MPM uses 
the EQPH entered on the Accounting Calendar divided by your 
choice of Baseline or ETC hours. If exporting CPR4 report to the 
UN/CEFACT format, select ETC in the Manpower Forecast 
conditioning field. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD. 
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2.10.1  CPR4 Report – 1989 Format

 



2.10.2  CPR4 Report – 1995 Format 
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 2.10.3  CPR4 Report – 2005 Format 

 

 



 You can limit the report to include only a specific WBS leg.  
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 WBS elements which are Over Target Baseline Date that 
you enter 

You can select the lowest report level for each WBS leg. 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

You can choose to calculate LRE values using your choice of 
these formulas: 

Choose the 1989, 1995 report format from the Report Format 
drop-down list 

 WBS elements with no values (because they have no 
estimates) 

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 

Report Formats Available 

Data Calculation Options 

 Variance Reconciliation 

Data Selection Options 

Data Inclusion Options 

 Cum ACWP + ETC 

You can choose to include: 

 Elements of Cost 

 BAC / CPI 2 
 BAC 

 

Undistributed Budget and Management Reserve values 
are derived from the Program Log, unless overridden in the 
Header information. 

The C/SSR icon provides the Cost/Schedule Summary Report, 
which is used in all levels of project management by government 
contractors and complies with DoD 5000.2 requirements.  

Definitions and instructions for these reports can be found in the 
DoDI publication 5000.2. 

 The 1989 OMB format report complies with OMB No. 
22R0327.  

You can enter Headers for this report by clicking the  icon 
next to the Project drop-down list box. This report includes 
header data showing contractor and contract information, and 
computed and override data about contract price, budget, 
Management Reserve (MR),  

Access the C/SSR Report Conditioning Window by selecting 
C/SSR on the Reports tab.  

 The 1995 DID report complies with OMB No. 0704-
0188 and DID No. DI-MGMT-81466.  

Undistributed Budget (UB), and MEAC cases. For detailed 
information on entering Header data, see topic 2.11.1 C/SSR 
Report Header Data. 

The C/SSR report is available in two formats:  

2.11  C/SSR Reports 

Conditioning Window 

Headers 
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2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE 
at the EOC level then summing the individual LRE's to get the WBS total. 
Parent WBS's are calculated in the same manner and thus are not summed up 
from the child level LRE's. 

Data Formatting Options 
 You can display dollars in Whole Numbers, Thousands, or 

Decimal Thousands. 
 You can choose to identify WBS by Alias or Cross-Ref-1 

instead of WBS ID. 

Report Source 
This report uses the files projectnameU.RRH, 
projectnameW.RRD, projectnameQ.LOG, and 
projectnameT.HED. 
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2.11.1  C/SSR Report Header Data 
Using the C/SSR Header function, you can define and store 
project information that appears on all C/SSRs prepared for your 
project. The details of entering the header data are given below. 

General Text 
Enter the text for the following fields in the same way you would 
on a printed form. 

 Contractor  Title  
 Location  Type 
 Program Name  Number 
 Contract Number  Phase 
 Approval Authority   Gen and Admin 

Gen and Admin 
If you select Add, the Performance Data values for each WBS 
shown in the body of the C/SSR do not include G&A. G&A is 
displayed as a separate item, and the values displayed for G&A 
are added when MPM calculates the Totals at the bottom of the 
C/SSR. 

If you select Non-Add, the Performance Data values include 
G&A. G&A is displayed as a separate item, and the values 
displayed for G&A are not added in again when MPM calculates 
the Totals at the bottom of the C/SSR. 

MEAC Calculation 
The first time you enter the C/SSR Header window, this field is 
blank. Thereafter, it defaults to your most recent selection. You 
can choose from the following options for this field: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 BAC 
 BAC / CPI 2 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE 
at the EOC level then summing the individual LRE's to get the WBS total. 
Parent WBS's are calculated in the same manner and thus are not summed up 
from the child level LRE's. 

MEAC Cum through Month 
Enter the month in MMMYY format to specify the month 
through which to accumulate ACWP and BCWP for the 
recalculation of MEAC. 

The first time you enter the C/SSR Header screen, the Cum 
through Month default to the last Report Month stored in the 
.OPT file. Thereafter, it defaults to your most recent entry. 

The month entered in this field is used to recalculate MEAC only 
when you select one of the following MEAC calculation options: 

 

 

 

Cum ACWP + ETC 
Cum ACWP + (BAC – CUM BCWP) 
Cum ACWP + ((cum BCWS + ETC) – cum BCWP) 
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Computed Columns 
These are not data entry fields. The values shown in this column 
are computed by MPM and, with the exception of MEAC, are 
derived from data stored in the Program Log. Any modifications 
that are made to log values will affect the Computed Column 
values. 

For the C/SSR: 

Original Contract Target = Log Entry #1 
Negotiated Contract Change = All subsequent log entries 

Current Target Cost = Total of Log Entry #1 and all 
subsequent entries 

For all CPRs: 

Negotiated Contract Change = All log entries 

Value Columns 
The Value columns are also computed by MPM and, with the 
exception of MEAC, are derived from data stored in the Program 
Log. Any modifications made to the log values will affect the 
Values column values. 

You can enter override values in any or all of the fields in the 
Value column. The override values affect only the CPRs and 
C/SSR. The values previously established and stored in the 
project will not be affected. 

With the exception of the Original Contract Target, Negotiated 
Contract Change, Current Target Cost and MEAC values, any 
changes in override values to the C/SSR will also be reflected in 
the CPRs, and vice versa. 

If you wish to override the Target Cost value, you must make the 
change on both the C/SSR and one of the CPRs. The reason for 
this is that the Negotiated Contract Cost field on the C/SSR and 
the CPRs do not contain the same information. The Current 
Target Cost field on the C/SSR equates to the Negotiated 
Contract Cost field on CPRs. 
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2.11.2  C/SSR Report – 1989 Format
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2.11.3  C/SSR Report – 1995 Format
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2.12  Compare Detail and Rollup Report 

Use the Compare Detail and Rollup report to compare the data in 
your detail and rollup data. If you have turned off the EOC or 
Summary rollup processing, or have made changes in your data 
which may affect rollup totals (such as deleting an EOC), you can 
use this report to compare the detail and the rollup totals and see if 
there is a problem that needs to be fixed.  

See Chapter 2: Creating and Maintaining Project Settings in the 
MPM Projects manual for details about setting the rollup toggle 
and rolling up data manually. 

Conditioning Window 
Access the Compare Detail and Rollup Report Conditioning 
Window by selecting Compare Detail and Rollup on the Reports 
tab. 

Report Types Available 
 Element of Cost Rollup  shows a comparison of EOC 

detail and rollup data. 
 Summary Rollup shows a comparison of Summary detail 

and rollup data. 

Report Source 
This report uses the files projectnameU.RRH, 
projectnameW.RRD, and projectnameT.HED. 
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2.13  Contract Line Items Report 

The Contract Line Items report is a tabular report of your CLIN 
table, listing description, quantity, reference codes, and element 
codes for each Contract Line Item. This report can be used to 
verify appropriate labeling and designation of line items. 

Conditioning Window 
Access the Contract Line Items Report Conditioning Window by 
selecting Contract Line Items on the Reports tab. 

The Contract Line Items report has no additional options beyond 
the standard options available on all Report Conditioning 
windows.  

Report Source 
This report uses the file projectnameR.CLN. 
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2.14  Control Account Plan Report 

The Control Account Plan is a comprehensive report of milestones 
and resources, which can be useful for tracking and statusing 
milestones, authorizing budget, and documenting schedule 
integration.  

This report only includes Control Account WBS elements and their 
children. Labor resources are reported in hours; nonlabor are 
shown as prime. 

Conditioning Window 
Access the Control Account Plan Report Conditioning Window by 
selecting Control Account Plan on the Reports tab.  

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 
 WBS elements that are still open (have not completed) 

Data Inclusion Options 
You can choose to include: 

 LRE values 
 Add a Cumulative Line in the Control Account Summary 

portion of the report 

Data Calculation Options 
You can choose to calculate LRE values using your choice of these 
formulas: 

 cumACWP + ETC 

 cumACWP thru Gate Month + ETC 1 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month. 

Data Formatting Options 
 You can insert Page breaks between work packages.  
 You can choose to identify Milestones by ID or description. 

Data Processing Options 
You can choose to Store Baseline Data once you are certain the 
data on the report is correct. Once you have stored the values for a 
particular month, you cannot report on a previous month. If you 
choose to skip a month between reports, the values for the skipped 
month(s) are added to the cumulative-to-date column. A month 
should be skipped only if no baseline changes occurred during the 
month. 
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The DD1861 icon provides the Contract Facilities Capital and Cost 
of Money Report, which is used to communicate methods of 
allocation of contractor facilities cost and is required by DoD. This 
report shows summarized totals of allocation pools. 

You can enter Headers for this report by clicking the  icon next 
to the Project list box. This report includes Treasury rate, proposal, 
and contract data. 

You can set the Starting Month of the Fiscal Year to be included; 
all months from that month on will be selected. 

Note the total of the Land, Building, and Equipment percentages 
must be 100%. 

Access the DD1861 Report Conditioning Window by selecting 
DD1861 on the Reports tab.  

You can choose whether to report Yearly or Monthly periods. 

This report uses the files projectnameU.RRH and 
projectnameW.RRD. 

Data Formatting Options 

2.15  DD1861 Report 

Data Selection Options 

Conditioning Window 

Report Source 

Headers 
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The DD1921 icon provides the Cost Data Summary Report, which 
is used to report contract cumulative-to-date ACWP and EAC by 
recurring, nonrecurring, CLIN, and WBS. This report is required 
by the DoD.  

You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box. This report includes contract 
price, ceiling, type, fiscal year funding, and contractor data. 

MPM provides the prescribed OBM form, which complies with 
Contract Cost Data Reporting (CCDR) requirements. 

Access the DD1921 Report Conditioning Window by selecting 
DD1921 on the Reports tab. 

You can limit the report to include only a specific WBS leg.  

You can display dollars in Whole Numbers, Thousands, or 
Decimal Thousands. 

You can choose to include WBS elements with no values. 

This report uses the files projectnameU.RRH and 
projectnameW.RRD. 

Data Formatting Options 

2.16  DD1921 Report 

Data Selection Options 

Data Inclusion Options 

Conditioning Window 

Report Source 

Headers 
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2.17  Detail Variance Analysis Report 
The Detail Variance Analysis is a comprehensive report of the 
most common analysis calculations for performance measurement, 
which can be useful for detailed analysis and forecasting. This 
report includes the formulae used in calculations. Out of tolerance 
areas are shown if users have entered program variance thresholds. 
Labor hours are reported; non labor units are excluded. 

Conditioning Window 
Access the Detail Variance Analysis Report Conditioning Window 
by selecting Detail Variance Analysis on the Reports tab. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 
 WBS elements that are still open (have not completed) 
 Out-of-tolerance items 

LRE (Data Calculation) Options 
You can choose to calculate LRE values using your choice of these 
formulas: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 BAC 
 BAC / CPI 2 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 

Cost Element Options 
You can choose either: Prime, Total Burdened, Total Cost, or Total 
Dollars. 

Program Variance Thresholds 
Variance thresholds are used to determine if a WBS element’s 
schedule, cost, or at complete variance are out of tolerance. You 
can enter both a fixed dollar amount and/or a percentage for 
monthly, cumulative, and at complete. If one or more of the 
variances is out of tolerance, the element shown on the report and 
the out of tolerance variances are marked with an asterisk.  

To access the WBS Threshold dialog box, use the WBS Threshold 
field on the WBS applet. 

Report Source 
This report uses the files projectnameU.RRH, 
projectnameW.RRD, projectnameQ.LOG, and 
projectnameT.HED.
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2.18  EAC Comparison Report 

The Estimate At Completion (EAC) Comparison Report shows 
multiple EACs for each WBS, which meets government 
requirements and can be useful for comparing mid-range numbers 
with LRE values.  

Conditioning Window 
Access the EAC Comparison Report Conditioning Window by 
selecting EAC Comparison on the Reports tab.  

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 
 WBS elements that are still open (have not completed) 

Data Calculation Options 
You can choose to calculate LRE values using your choice of these 
formulas: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 
 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 BAC 
 BAC / CPI 2 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

2 Since this calculation involves division, a simple rollup of EAC values is not 
appropriate. The value for each WBS EAC is obtained by calculating the EAC at 
the EOC level then summing the individual EAC's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level EAC's. 

Data Inclusion Options 
You can also choose to include in the report: 

 Project Summary 
 Variance Reconciliation 

Data Formatting Options 
You can choose either: Prime, Total Burdened, Total Cost, or Total 
Dollars.
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2.19  EVM Plan and Analysis Report 

The Earned Value Method (EVM) Plan and Analysis Report shows 
status and earning history for all work packages and milestones, 
which can be useful for Control Account Managers to perform 
detail milestone planning and analyze performance at the milestone 
level.  

This report can also be used to verify appropriate weighting of 
milestones against BCWS, or for analysis of BCWP status and 
milestone status.  The system always uses forecast dates (not 
schedule dates) to calculate milestone weights. 

Conditioning Window 
Access the EVM Plan and Analysis Report Conditioning Window 
by selecting EVM Plan and Analysis on the Reports tab.  

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 
 a specified number of years 

Data Formatting Options 
You can choose to add page breaks between WBS Elements. 

Milestone Information 
In the Milestone Information section, the weights are displayed by 
Forecast date, not Schedule date. The Acctg month displays the 
fiscal month of the Forecast date. 

Report Source 
This report uses the files projectnameI.BWP and 
projectnameA.MIL.
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2.20  Element of Cost Reports 

The Element of Cost icon provides the following reports: 

 

 

 

 

 

 

 

 

 

 

 

Element of Cost – Baseline 
Actuals by EOC 
Actuals by Charge Number 
EOC/Class Detail – Baseline 
EOC/Class Detail – ETC 
Element of Cost – ETC 
Element of Cost – LRE 
S/P/A Tabular by EOC 
S/P/A Recap by Element of Cost 
Element of Cost Baseline – Recap 
Element of Cost Budget/Actuals - Recap 

You can access all of these reports from the Element of Cost 
Conditioning Window. 

Conditioning Window 
Access the Element of Cost Report Conditioning Window by 
selecting Element of Cost on the Reports tab. 

Selecting the Desired Element of Cost Report 
To access the Element of Cost Report from the list above, click the 
Report Type criteria drop-down list box, as. The options for the 
Element of Costs reports are detailed below. Each of the 11 reports 
available from this conditioning window is detailed in topics 
2.20.1 through 2.20.11.  

Data Selection Options 
You can limit these reports to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 

Data Inclusion Options 
You can also choose to include in these reports: 

 Report Timeframe 
• Incremental  
• Cumulative 
• At-complete values 

 Grand totals only 
 Cost Elements 

• Standard Hours  
• Hours  
• Prime  
• Overhead  
• Total Burdened  
• G&A  
• Total Cost  
• Cost of Money  
• Total Dollars  
• Fee  
• Total Price 
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• Grand Totals, in either the EOC subtotals, and/or the 
grand totals section of the report.  

These options are displayed as check boxes for each 
individual combination, for example Overhead (EOC 
Section) prompts if you want to add a subtotal for Overhead 
to the EOC section of the report. Place check marks next to 
all totals and subtotals you want to include. 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe).  Calculation of cumulative values to be 
included in the report is based on the report timeframe you choose.  
If you want to include total cumulative data for actuals, you must 
include the entire project timeframe. 

Data Formatting Options 
You can choose to report detail or summary values under 
Data Type. 
You can add Page Breaks between WBS Elements if 
desired. 
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2.20.1  Baseline EOC Report 
The Baseline EOC report provides timephased resource summary 
data at any level of the WBS, and subtotals for each EOC. 

Conditioning Window 
Access the Baseline EOC Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type Baseline.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. 
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2.20.2  Actuals EOC by WBS Report 
The Actuals EOC by WBS report provides actuals by timephased 
EOC. All actuals are included whether they are reported by 
resource or EOC. This report is sorted by WBS, and shows 
subtotals for each EOC and for the entire project. 

Conditioning Window 
Access the Actuals EOC by WBS Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type Actuals by WBS. MPM displays the Actuals 
by WBS Report Conditioning Window. 

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. 
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2.20.3  Actuals by Charge Number Report 
The Actuals by Charge Number report provides actuals by 
timephased EOC. All actuals are included whether they are 
reported by resource or EOC. This report is sorted by Charge 
Number, and shows subtotals for each EOC and for the entire 
project. 

Conditioning Window 
Access the Actuals by Charge Number Report Conditioning 
Window by selecting the Elements of Cost icon on the Reports tab, 
and selecting Report Type Actuals by Charge Number.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. 
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2.20.4  EOC/Class-Baseline Report 
The EOC/Class - Baseline report provides baseline estimate data 
sorted by EOCs and Classes of Cost (COCs) for analysis. Labor 
hour are totaled; nonlabor units are reported but not totaled. 

Conditioning Window 
Access the EOC/Class - Baseline Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type EOC/Class - Baseline.  

Additional Conditioning Options 
This report provides different Cost Elements conditioning options 
as those described in topic 2.20  Element of Cost Reports. This 
report provides subtotals of all Cost Elements you select. 
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2.20.5  EOC/Class-ETC Report 
The EOC/Class - ETC report provides ETC estimate data sorted by 
EOCs and Classes of Cost (COCs) for analysis. Labor hour are 
totaled; nonlabor units are reported but not totaled. 

Conditioning Window 
Access the EOC/Class - ETC Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type EOC/Class - ETC.  

Additional Conditioning Options 
This report provides different Cost Elements conditioning options 
as those described in topic 2.20  Element of Cost Reports. This 
report provides subtotals of all Cost Elements you select. 
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2.20.6  EOC-ETC Report 
The EOC - ETC report provides timephased resource detail for 
ETC by WBS. This report contains subtotals for each EOC and 
totals for the entire project. 

Conditioning Window 
Access the EOC - ETC Report Conditioning Window by selecting 
the Elements of Cost icon on the Reports tab, and selecting Report 
Type ETC.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. 

 

 



 
 

 MPM Standard Reports    111 



Chapter 2: Report Descriptions and Examples 112 

 

2.20.7  EOC-LRE Report 
The EOC - LRE report provides actuals and ETC by WBS. This 
report contains subtotals for each EOC and totals for the entire 
project, and can be used for EAC justification. 

Conditioning Window 
Access the EOC - LRE Report Conditioning Window by selecting 
the Elements of Cost icon on the Reports tab, and selecting Report 
Type LRE.  

Additional Conditioning Options 
This report provides the conditioning options described in topic 
2.20  Element of Cost Reports. In addition, there are two additional 
conditioning options: Gate Month and LRE Calculation Option. 
Actuals are reported through the Gate Month, and ETC values are 
reported after the Gate Month. LRE can be calculated as Cum 
ACWP + ETC, or Cum ACWP through Gate Month + ETC. 
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2.20.8  S/P/A Tabular Report by EOC 
The S/P/A Tabular Report by EOC provides baseline and 
performance data, and includes cost and schedule variances. This 
report can be used by all levels of project management for 
managing the baseline in a government contracting environment. 

Conditioning Window 
Access the S/P/A Tabular Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type S/P/A Tabular.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. 
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2.20.9  S/P/A Recap Report by EOC 
The S/P/A Recap Report by EOC provides cumulative-to-date 
performance and associated cost and schedule variances as 
compared to performance. This report can be used by all levels of 
project management for internal reporting of performance, and in 
preparation of CPR reports. 

Conditioning Window 
Access the S/P/A Recap Report Conditioning Window by selecting 
the Elements of Cost icon on the Reports tab, and selecting Report 
Type S/P/A Recap.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. 
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2.20.10  Baseline Recap Report by EOC 
The Baseline Recap report provides summary proposal or baseline 
budget data with EOC reconciliation. This report contains subtotals 
for each EOC and totals for the entire project, and lists WBS 
elements indented by level. 

Conditioning Window 
Access the Baseline Recap Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type Baseline Recap.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. However, it does not allow you specify cost 
elements or subtotals to include, because all are always listed. 
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2.20.11  Budget/Actuals Recap Report by EOC 
The Budget/Actuals Recap report provides cumulative-to-date 
comparison of budget versus actuals with variances. This report 
contains subtotals for each EOC and totals for the entire project, 
and lists budget and summarized budget values. 

Conditioning Window 
Access the Budget/Actuals Recap Report Conditioning Window by 
selecting the Elements of Cost icon on the Reports tab, and 
selecting Report Type Budget/Actuals Recap.  

Additional Conditioning Options 
This report only provides the conditioning options described in 
topic 2.20  Element of Cost Reports. There are no additional 
conditioning options. However, it does not allow you specify cost 
elements or subtotals to include, because all are always listed. 
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2.21  Element of Cost Table Report 

The Element of Cost Table report is a tabular report of your 
Element of Cost Table. You use the Element of Cost Table report 
to check your Elements of Cost (EOCs) and Classes of Cost 
(COCs). 

Conditioning Window 
Access the Element of Cost Table Report Conditioning Window 
by selecting Element of Cost Table on the Reports tab. 

The Element of Cost Table report has no additional options beyond 
the standard options available on all Report Conditioning 
windows.  

Report Source 
This report uses the EOCCODES.LIB (the EOC codes in the 
Resource Library) database. 
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2.22  Labor/Price Summary Reports 

The Labor/Price Summary icon provides two tabular, timephased 
reports: Labor/Price Summary by WBS or by CLIN. These reports 
show labor summary by COC, and price summary by EOC/COC 
for direct and indirect labor.  

Conditioning Window 
Access the Labor/Price Summary Report Conditioning Window by 
selecting Labor/Price Summary on the Reports tab. 

Report Types Available 
 WBS shows Labor/Price Summary analysis of timephased 

budgets by WBS. 
 CLIN shows Labor/Price Summary analysis of timephased 

budgets by CLIN. 

Report Periods Available 
 Month shows monthly Labor/Price Summary  
 Quarter shows quarterly Labor/Price Summary  
 Year shows yearly Labor/Price Summary  

Data Types Available 
 Detail shows detailed and summary Labor/Price data  
 Summary shows only summary Labor/Price data  

Levels of Detail Available 
 Element of Cost shows Labor/Price Summary by EOC 
 Class of Cost shows Labor/Price Summary  by EOC and 

COC 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 
 Number of Years to continue the report after the Report 

Start date 

Data Inclusion Options 
You can choose to include: 

 incremental values 
 cumulative values 
 at-complete values 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe).  
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Data Formatting Options 
 You can display dollars in Whole Numbers, Thousands, or 

Decimal Thousands. 
 You can insert Page Breaks between WBS Elements.  

Report Source 
This report uses the projectnameU.RRH and projectnameW.RRD 
databases. 

 

 



2.22.1  Labor/Price Summary Report by WBS 
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2.22.2  Labor/Price Summary Report by CLIN 
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2.23  Logs Reports 

The Logs icon provides three tabular reports of your Management 
Log, which lists the historical record of Contract Budget Baseline 
(CBB) and Total Allocated Budget (TAB). You can use the Logs 
reports to reconcile current contract budgets to original budgets 
and compare values to contract target cost.  

This report can be used by government contractors in preparation 
of CPR Formats 8 and 9. 

Conditioning Window 
Access the Logs Report Conditioning Window by selecting Logs 
on the Reports tab. 

The Logs report, except for Report Type (see below) has no 
additional options beyond the standard options available on all 
Report Conditioning windows.  

Report Types Available 
 Program Log shows all individual transactions in the 

Program Log. 
 Management Reserve Log shows individual Management 

Reserve transactions integrated with the Program Log. 
 Undistributed Budget Log shows individual Undistributed 

Budget transactions integrated with the Program Log. 

Report Source 
This report uses the projectnameQ.LOG database. 
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2.23.1  Program Log Report 
 

 

 



2.23.2  Management Reserve Log Report 
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2.23.3  Undistributed Budget Log Report 
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2.24  Manpower Reports 

The Manpower icon provides two tabular, timephased reports: 
Manpower Detail or Manpower Summary. These reports show 
manpower loading against labor, with subtotals for each labor 
category and totals for the entire project.  

The Equivalent Person calculation is based on the type of 
work calendar selected on the Project Maintenance window.  
This calculation will only be included on this report if EQP 
hours have been entered on the Fiscal Calendar. 

Conditioning Window 
Access the Manpower Report Conditioning Window by selecting 
Manpower on the Reports tab. 

Report Types Available 
 Detail shows Manpower loading with hours and equivalent 

people sorted by labor categories. 
 Summary shows either detail by WBS or hours and 

equivalent people summarized by labor categories, 
depending on whether higher or lower levels of estimating 
are selected. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 

 OBS performing/responsible departments, a specific 
department, a specific CLIN 

 specific Labor EOC code and/or COC code (if left empty, 
all Labor EOCs are included in the report) 

 a specific Resource Code, Resource Department, XREF-
EST 

 Number of Years to continue the report after the Report 
Start date 

Data Inclusion Options 
You can choose to include: 

 incremental values 
 cumulative values 
 at-complete values 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe). 

Data Formatting Options 
You can display Grand Totals Only. 

Report Source 
This report uses the projectnameU.RRH and projectnameW.RRD 
databases.
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2.24.1  Manpower Detail Report 
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2.24.2  Manpower Summary Report 
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2.25  Milestone Barchart Report 

The Milestone Barchart report contains a combination milestone 
and Gantt chart with WBS elements shown as bars and milestones 
shown under the bars using the standard milestone symbols. Each 
milestone’s schedule and forecast dates are shown, and each WBS 
shows the earned value method (EVM) assigned.  

This report can be used in management presentations to show slips 
in milestones and WBS completion status. 

Milestone shading in the barchart is based on BCWP and 
BCWS, not on time or duration.  

The float values depicted on this chart are not network float 
values. MPM uses the difference between baseline and 
early/late dates to determine the amount of resource 
movement available. 

Conditioning Window 
Access the Milestone Barchart Report Conditioning Window by 
selecting Milestone Barchart on the Reports tab. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 WBS elements scheduled between Report Start and Report 

Through  

Data Inclusion Options 
You can choose to include only WBS elements on the critical path 
in the report by selecting Include Critical Only. 

Data Sorting Options 
You can sort this report using one (Primary) or two (Primary and 
Secondary) fields from the following list:  

 Early Start 
 Early Finish 
 Late Start 
 Late Finish 
 Baseline Start 
 Baseline Finish 
 ETC Start 
 ETC Finish 
 XREF fields 1-10 
 Total Float 

Data Formatting Options 
You can change the Reference Time Now Date, which affects the 
Time Now line drawn vertically down the barchart. You can used a 
formulated date (see Chapter 1 for details) to amend the placement 
of the Time Now line. This function uses the Current Date which 
you can set to affect Time Now also.  
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For example, if today is 1-Oct-07 and you set Reference Time Now 
Date to <current>+14d, the Time Now line is drawn at 15-Oct-07. If 
you change the Current Date to 1-Dec-07, the Time Now date is 
drawn at 15-Dec-07. 

 You can Include Float Lines which depict the amount of 
float in the schedule. If you do show the float lines, you can 
change the Critical Float Threshold, which determines 
whether or not the amount of float is depicted as Critical. 

 This report inserts a page break between each WBS element. 
You can Suppress Page Break if desired, which will insert a 
page break only when necessary. 

 You can Identify Milestones by Description, ID, or both. 

Report Source 
This report uses the projectnameP.WBS and projectnameA.MIL 
databases. 
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 MPM Standard Reports    145 



Chapter 2: Report Descriptions and Examples 146 

 

2.26  Milestone Status Turnaround Document 

The Milestone Status Turnaround Document contains all 
milestones of the WBS elements selected. This report is intended 
for data collection purposes. 

Conditioning Window 
Access the Milestone Status Turnaround Document Report 
Conditioning Window by selecting Milestone Status Turnaround 
Document on the Reports tab. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 

 OBS performing/responsible departments, a specific 
department, a specific CLIN 
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You can choose to calculate LRE values using your choice of these 
formulas: 

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 

Once this check box is clicked, you can enter unfilled order 
numbers against each selected WBS leg, EOC, and Unit shown. If 
you change the WBS legs in the report, MPM only allows entry of 
unfilled order numbers of the WBS legs you have selected. 

To add unfilled order numbers to your report, first double-click in 
the gray Unfilled Order Numbers criteria box to display a check 
mark (see below).  

 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 

Adding Unfilled Order Numbers 

Data Calculation Options 

 Cum ACWP + ETC 

 BAC / CPI 2 
 BAC 

 You can limit the report to include only a specific WBS leg.  

The NASA 533M icon provides the Monthly Contractor Financial 
Management Report, which is used in all levels of project 
management by NASA contractors and complies with NASA NHB 
9501.2b requirements.  

 You can display dollars in Whole Numbers, Thousands, or 
Decimal Thousands. 

Select a period for the Detail Increments fields. Column A 
and B refer to the Estimate to Complete columns of the 
NASA 533M report. 

You can enter Headers for this report (and the 533P and 533Q 
reports) by clicking the  icon next to the Project drop-down list 
box.  

 Actuals are reported through the Gate Month, and ETC 
values are reported after the Gate Month specified. 

Access the NASA 533M Report Conditioning Window by 
selecting NASA 533M on the Reports tab.  

The header information is used by the three 533 reports. 

2.27  NASA 533M Report 

Enter the General Text fields. 

Data Formatting Options 

Data Selection Options 

Conditioning Window 

Headers 
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You can choose to calculate LRE values using your choice of these 
formulas: 

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 

Once this check box is clicked, you can enter %Complete against 
each selected WBS leg, EOC, and Unit shown. If you change the 
WBS legs in the report, MPM only allows entry of %Complete of 
the WBS legs you have selected.

 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

To add Technical Percent Complete to your report, first double-
click in the gray Technical %Complete criteria box to display a 
check mark (see below).  

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

Adding Technical Percent Complete Data 

 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 

Data Calculation Options 

 Cum ACWP + ETC 

 BAC / CPI 2 
 BAC 

 Actuals are reported through the Gate Month, and ETC values 
are reported after the Gate Month specified. 

 You can limit the report to include only a specific WBS leg.  

The NASA 533P icon provides the Monthly Contractor Financial 
Performance Analysis Report, which is used in all levels of project 
management by NASA contractors and complies with NASA NHB 
9501.2b requirements. 

Access the NASA 533P Report Conditioning Window by selecting 
NASA 533P on the Reports tab.  

Select a period for the Detail Increments fields. Column A 
and B refer to the Estimate to Complete columns of the 
NASA 533M report. 

You can enter Headers for this report (and the 533M and 533Q 
reports) by clicking the  icon next to the Project drop-down list 
box.  

The header information is used by the three 533 reports. 

2.28  NASA 533P Report 

Enter the General Text fields. 

Data Selection Options 

Conditioning Window 

Headers 
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You can choose to calculate LRE values using your choice of these 
formulas: 

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE at 
the EOC level then summing the individual LRE's to get the WBS total. Parent 
WBS's are calculated in the same manner and thus are not summed up from the 
child level LRE's. 

Once this check box is clicked, you can enter unfilled order 
numbers against each selected WBS leg, EOC, and Unit shown. If 
you change the WBS legs in the report, MPM only allows entry of 
unfilled order numbers of the WBS legs you have selected.

To add unfilled order numbers to your report, first double-click in 
the gray Unfilled Order Numbers criteria box to display a check 
mark (see below).  

 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 

 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 

Adding Unfilled Order Numbers 

Data Calculation Options 

 Cum ACWP + ETC 

 BAC / CPI 2 
 BAC 

 Actuals are reported through the Gate Month, and ETC values 
are reported after the Gate Month specified. 

 You can limit the report to include only a specific WBS leg.  

Access the NASA 533Q Report Conditioning Window by selecting 
NASA 533Q on the Reports tab.  

The NASA 533Q icon provides the Quarterly Contractor Financial 
Management Report, which is used in all levels of project 
management by NASA contractors and complies with NASA NHB 
9501.2b requirements.  

 You can display dollars in Whole Numbers, Thousands, or 
Decimal Thousands. 

Select a period for the Detail Increments fields. Column A 
and B refer to the Estimate to Complete columns of the 
NASA 533M report. 

You can enter Headers for this report (and the 533P and 533M 
reports) by clicking the  icon next to the Project drop-down list 
box.  

The header information is used by the three 533 reports. 

2.29  NASA 533Q Report 

Enter the General Text fields. 

Data Formatting Options 

Data Selection Options 

Conditioning Window 

Headers 
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2.30  OBS Burden Template Report 

The OBS Burden Template report provides a tabular report listing 
all burden templates which have been assigned at the department 
level. This report can be used for reference and verification of 
burden templates assigned to the OBS. 

Conditioning Window 
Access the OBS Burden Template Report Conditioning Window 
by selecting OBS Burden Template on the Reports tab. 

Data Selection Options 
You can limit the report to include only:  

 OBS performing/responsible departments 
 a specific OBS department 

Report Source 
This report uses the files projectnameB.OBS and 
TEMPLATE.LIB. 
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2.31  OBS Indented Report 

The OBS Indented report provides a tabular report listing all OBS 
departments in an indented format to depict OBS levels. This 
report can be used for reference and verification of OBS 
departments. 

Conditioning Window 
Access the OBS Indented Report Conditioning Window by 
selecting OBS Indented on the Reports tab. 

Data Selection Options 
You can limit the report to include only:  

 OBS performing/responsible departments 
 a specific OBS department 

Report Source 
This report uses the projectnameB.OBS database. 
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2.32  Price/Usage Variance Analysis Report 

The Price/Usage Variance Analysis icon provides a tabular report 
showing several analysis computations normally found in the 
performance measurement environment.  

Computations Performed 
The computations this report performs use the following formulas. 
All formulas used are also printed on the first page of the report. 

 

 

 

Budget variances by EOC are provided by comparing 
budget and actuals. 
Efficiency variances by EOC are provided by comparing 
BCWP and actuals. 
Labor price variances are displayed in the budget and 
efficiency variance columns. 

Conditioning Window 
Access the Price/Usage Variance Analysis Report Conditioning 
Window by selecting Price/Usage Variance Analysis on the 
Reports tab. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg, element, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 

Data Inclusion Options 
You can choose to include only open WBS elements. 

Data Usage Options 
You must choose one of the following Cost Elements to use in the 
calculations for this report:  

 Prime Dollars  
 Total Burdened  
 Total Cost  
 Total Dollars 

The cumulative values for labor categories as shown on this report 
include values for all EOCs defined as Labor EOCs; all other 
EOCs report prime dollars. 

Report Source 
This report uses the projectnameU.RRH and projectnameW.RRD 
databases.
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2.33  Project Comparison Reports 

The Project Comparison icon provides four reports which 
compare two projects.   You can compare Baseline, LRE, 
Timephased Baseline and Timephased LRE values. 

In order to provide a meaningful comparison, both projects 
must have a similar WBS and EOC Table. 

Conditioning Window 
Access the Project Comparison Report Conditioning Window by 
selecting Project Comparison on the Reports tab. 

Projects 
You must select the Project and the Comparison Project to be 
compared against. 

Report Types Available 
 Baseline compares the two project’s Baseline 

values. 
 LRE compares the two project’s LRE values. 
 Timephased Baseline compares the two project’s 

timephased Baseline values. 
 Timephased LRE compares the two project’s 

timephased LRE values. 
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2.33.1  Project Comparisons: Baseline and LRE Reports 

The Baseline and LRE reports include a WBS summary, annual 
recap, and project summary for each project being compared.  You 
can use these reports to compare in-house standard projects to a 
contractor’s project proposal, or to compare project variances. 

Data Selection Options 
You can limit the report to include only: 

 any WBS leg 
 in the main report section, data starting in the Report 

Start month 
 Number of Years to continue the report after the 

Report Start date 
 in the Recap section, data starting in the Start Month  

Data Inclusion Options 
You can choose to include: 

Zero WBS elements (empty elements which have no 
estimates) 
a WBS Summary at the end of the report comparing WBS 
summary data 
an Annual Recap at the end of the report 
particular WBS legs in the indicated Reporting Levels 

Data Calculation Options 
 You can choose to calculate cumulative values from 

Inception (Project Start date) or Report Start (the 
Report Start date you enter under Report Timeframe).  

 You can set a Tolerance Percent and if desired show 
Out of Tolerance Items Only to trap the comparisons 
which are at least as different as the Tolerance Percent, 
if not more. 

Data Usage Options 
You must choose one of the following Cost Elements to use in the 
calculations for this report: Prime Dollars, Total Burdened, Total 
Cost, or Total Dollars.  

Report Source 
This report uses the projectnameU.RRH and projectnameW.RRD 
databases.

 



 2.33.1a  Project Comparison Baseline Report 

 

 MPM Standard Reports    163 



Chapter 2: Report Descriptions and Examples 164 

 

 



2.33.1b  Project Comparison LRE Report 
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2.33.2 Project Comparison: Timephased Baseline & LRE Reports 

The Timephased Baseline and Timephased LRE values reports 
provide a comparison of the timephased data at any level of the 
WBS, and subtotals for each EOC. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 specific EOC codes 

Conditioning Options 
You can also choose to include: 

 Incremental, cumulative, and/or at-complete values 
 Grand totals only 
 Cost Elements:  
• Standard Hours 
• Hours 
• Prime 
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 

• Total Price 
• Grand Totals, in either the EOC subtotals, and/or the 

grand totals section of the report 
These options are displayed as check boxes for each individual 
combination, for example Overhead (EOC Section) prompts if 
you want to add a subtotal for Overhead to the EOC section of 
the report. Place check marks next to all totals and subtotals you 
want to include. 

In Addition, there are three additional conditioning options 
available for the Timephased LRE report: 
 

 LRE Option: LRE can be calculated as: 
• cumACWP + ETC, or 
• cumACWP through GATE Month + ETC 

 Gate Month 
 Comparison Project Gate Month 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you 
enter under Report Timeframe).  Calculation of cumulative 
values to be included in the report is based on the report 
timeframe you choose.   
If you want to include total cumulative data for actuals, you must 
include the entire project timeframe. 

Data Formatting Options 
 You can choose to report detail or summary values under 

Data Type. 
 You can add Page Breaks between WBS Elements if 

desired. 
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2.33.2a  Project Comparison Timephased Baseline Report 
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2.33.2b  Project Comparison Timephased LRE Report 
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2.34  Proposal Summary Reports 

The Proposal Summary report provides two tabular reports 
which provides a total recap of proposal data, sorted and 
accumulated either by WBS or by CLIN. You can use these 
reports to provide supporting data for proposals and contract 
modifications, or for presentation, analysis, or government 
reviews. 

The EQP calculation is based on the type of work calendar 
selected on the Project Maintenance window. This 
calculation will be included in this report only if EQP hours 
have been entered on the Fiscal Calendar. 

Conditioning Window 
Access the Proposal Summary Report Conditioning Window by 
selecting Proposal Summary on the Reports tab. 

Report Types 
 

 

 

Proposal Summary by WBS summarizes proposal data by 
WBS. 
Proposal Summary by CLIN summarizes proposal data 
by Contract Line Item. 

Data Selection Options 
You can limit these reports to include only: 

• a particular WBS leg, element type, or level of the 
WBS 

• specific WBS Aliases, Managers, Cross-References, 
recurring/nonrecurring items 

• OBS performing/responsible departments, a specific 
department, a specific CLIN 

specific EOC codes 

Each EOC is listed separately, and for each, you can 
choose the level of detail to report: EOC, COC, or 
Resource. You can also choose to report Summarized 
Labor Elements of Cost. If you choose not to summarize 
Labor EOCs, each EOC listing also contains the option to 
not include the EOC.  

Data Inclusion Options 
You can also choose to include in these reports: 

• Report Timeframe 
• Incremental  
• Cumulative 
• At-complete values 

• Place check marks next to all Cost Elements you 
want to include:  

• Hours 
• Equivalent Person Months 
• Prime  
• Rate 
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 
• Total Price 
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Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you 
enter under Report Timeframe).  
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2.34.1  Proposal Summary Report by WBS  
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2.34.2  Proposal Summary Report by CLIN 
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2.35  Resource Reports 

The Resource icon provides seven tabular reports which provide 
timephased budget and ETC detail or summary data about 
resources. You can use these reports for budget justification, day-
by-day report of budget changes, or as a spending plan. 

The EQP calculation is based on the type of work calendar 
selected on the Project Maintenance window. This 
calculation will be included in this report only if EQP hours 
have been entered on the Fiscal Calendar. 

Conditioning Window 
Access the Resource Report Conditioning Window by selecting 
Resource on the Reports tab. 

Report Types 
 

 

 

 

 

 

 

 

 

Resource Detail – Baseline shows detailed resource 
baseline data. 
Resource Detail – Actuals shows detailed resource 
Actuals data. 
Resource Detail – ETC shows detailed resource ETC data. 
Resource Detail – Budget/LRE shows detailed resource 
Budget/LRE data. 
Resource Summary – Baseline shows summary resource 
baseline data. 
Resource Summary – Actuals shows summary resource 
Actuals data. 
Resource Summary – ETC shows summary resource ETC 
data. 

 
 
Data Selection Options 
You can limit these reports to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
a specific EOC or COC 
a specific Resource Code, Resource Department, XREF-
EST, Overtime 

Data Inclusion Options 
You can also choose to include in these reports: 

 Report Timeframe 
• Incremental  
• Cumulative 
• At-complete values 

 Place check marks next to all Cost Elements you want to 
include:  
• Standard Hours 
• Hours/Units 
• Equivalent Person Months 
• Prime 
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
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• Fee 
• Total Price 

Data Calculation Options 
 You can choose to calculate cumulative values from 

Inception (Project Start date) or Report Start (the Report 
Start date you enter under Report Timeframe).  

 On the Detail – Budget/LRE Report, there are two 
additional conditioning options: Gate Month and LRE 
Calculation Option. Actuals are reported through the Gate 
Month, and ETC values are reported after the Gate Month. 
LRE can be calculated as Cum ACWP + ETC or Cum 
ACWP through Gate Month + ETC. 

Data Formatting Options 
You can add Page Breaks between WBS Elements or 
Estimates/Actuals if desired. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD. 
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2.35.1  Resource Detail - Baseline Report 

   

 



2.35.2  Resource Detail - Actuals Report 
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2.35.3  Resource Detail - ETC Report 
 

 

 



2.35.4  Resource Detail – Budget/LRE Report 
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2.35.5  Resource Summary – Baseline Report 

 
 

 



2.35.6  Resource Summary - Actuals Report 
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2.35.7  Resource Summary - ETC Report 
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2.36  Resource Department Summary Report 

The Resource Department Summary icon provides the lowest level 
of timephased budget detail and constitutes the project baseline at 
the resource level. You can use this report to show resource 
profiles at summary levels, and resource requirements for project 
staffing, as supportive detail for proposals, analysis, and 
government reviews. 

The EQP calculation is based on the type of work calendar 
selected on the Project Maintenance window. This 
calculation will be included in this report only if EQP hours 
have been entered on the Fiscal Calendar. 

Conditioning Window 
Access the Resource Department Summary Report Conditioning 
Window by selecting Resource Department Summary on the 
Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 a specific Resource Code, Resource Department,  XREF-

EST, EOC or COC 

Data Inclusion Options 
You can also choose to include in these reports: 

 Report Timeframe 
• Incremental  
• Cumulative 
• At-complete values 

 Cost Elements:  
• Standard Hours 
• Hours 
• Equivalent Person Months 
• Prime 
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 
• Total Price 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe)  
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Data Formatting Options 
 

 You can display dollars in Whole Numbers, Thousands, or 
Decimal Thousands. 

You can limit the Level of Detail to the EOC, COC, or 
Resource level. 

You can add Page Breaks between Departments if desired. 
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2.37  Resources and Burdens Report 

The Resources and Burdens report is a complete list of all 
resources, resource rates, burdens, and burden rates for the 
specified Global File. This report is organized in fiscal month/year 
sequence, and provides the resource work calendar for estimating.  

You can use this report to price one hour’s worth of labor 
resources, for reference or verification of the DCAS/DCAA 
approved rates, or budgeted/experience rates. 

This report will only price resources that are Labor EOCs. 

Data Selection Options 
You can limit this report to include only: 

 

 

 

a specific EOC  
a specific Rate Table 

Data Inclusion Options 
Place check marks next to all Cost Elements you want to 
include:  
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 
• Total Price 

 You can choose to include Zero Burden and Zero Labor 
elements (elements that have no values). 

Data Formatting Options 
You can choose whether to report Monthly, Quarterly, or Yearly 
periods. 

Report Source 
This report uses the RESOURCE.LIB and RATE.LIB databases.
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2.38  Responsibility Assignment Report 

The Responsibility Assignment report cross-references the work to 
be done (WBS) with responsible and/or performing departments 
and managers (OBS). 

Conditioning Window 
Access the Responsibility Assignment Report Conditioning 
Window by selecting Responsibility Assignment on the Reports 
tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 

Report Source 
This report uses the files projectnameP.WBS and 
projectnameB.OBS. 
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2.39  Responsibility Assignment Matrix Report 

The Responsibility Assignment Matrix report graphically 
illustrates the WBS/OBS matrix and prints the dollar budget 
(BAC) associated with each intersection. You can use this report to 
reference the budgets represented by the WBS/OBS relationships.  

This report is often referred to in government C/SCSC 
demonstrations and Subsequent Applications Reviews (SARs). 

You must have OBS assignments at the lowest levels of the 
WBS tree. 

Conditioning Window 
Access the Responsibility Assignment Matrix Report Conditioning 
Window by selecting Responsibility Assignment Matrix on the 
Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 

Data Formatting Options 
You choose which Cost Element to depict in this report:  

 Hours 
 Prime Dollars 
 Total Burdened 
 Total Cost 
 Total Dollars 
 Total Price 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD.
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To print this report using the old (pre-1995) format, leave the New 
Report Format criteria box empty. To use the new format, put a 
check mark in the criteria box. 

This report uses the files projectnameU.RRH and 
projectnameW.RRD. 

Data Formatting Options 

Report Source 

Previous versions of MPM came with a blank SF 1411 form 
imprinted on a clear plastic overlay sheet, which provided 
the final report formatting. In this version of MPM, the 
overlay sheet is not necessary. The report prints with all 
formatting included. 

The SF 1411 is the Contract Pricing Proposal Cover Sheet required 
by DoD containing all government-required information for your 
proposal, sorted by CLIN. This report can be generated in two 
formats: old (pre-1995) and new.  

You can enter Headers for this report by clicking the  icon next 
to the Project drop-down list box. This report includes header data 
showing offeror, audit, and administration information, and values 
for cost, profit/fee, and total.  

To place a check in one of these fields, click the check mark at the 
end of the field. Clicking the check mark again will remove the 
check mark. 

Access the SF 1411 Report Conditioning Window by selecting SF 
1411on the Reports tab. 

Several of the fields offer drop-down lists from which you can 
choose an appropriate value. Many of the fields are check boxes.  

This report can accommodate up to 400 CLIN assignments, and 
assumes that you have placed CLIN assignments on WBS 
elements.  

2.40  SF 1411 Report 

Conditioning Window 

Headers 
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2.41  Spread Curve Report 

The Spread Curve report shows all predefined and user-defined 
spread curves in your project. You can optionally add a graph 
which depicts the spread curve graphically. 

Conditioning Window 
Access the Spread Curve Report Conditioning Window by selecting 
Spread Curve on the Reports tab. 

Data Formatting Options 
To list the numeric factors in each Spread Curve, leave the Display 
Graph criteria box empty. To depict each Spread Curve 
graphically, put a check mark in the criteria box. 

Report Source 
This report uses the DISTCURV.DAT database. 
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2.41.1  Spread Curve Report – Numeric Factors 
 

 

 



2.41.2  Spread Curve Report – Graphical Depiction 
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2.42  Task Description Report 

The Task Description report contains the narrative description of 
each WBS element. You can use this report as a WBS 
dictionary, or to communication Statement of Work for planning 
and estimating. Task Descriptions also appear on the Basis of 
Estimate report to describe the scope of work covered. 

Conditioning Window 
Access the Task Description Report Conditioning Window by 
selecting Task Description on the Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 

Report Source 
This report uses the projectnameD.WTD and 
projectnameP.WBS databases. 
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2.43  Variance Analysis Turnaround Document 

The Variance Analysis Turnaround Document contains BCWS, 
BCWP, ACWP, and cost and schedule variances by WBS for the 
selected period. You can distribute this document to management 
to request justification for variances. 

Conditioning Window 
Access the Variance Analysis Turnaround Document Report 
Conditioning Window by selecting Variance Analysis Turnaround 
Document on the Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 only those WBS elements which are Out of Tolerance  

Data Calculation Options 
You can choose to calculate LRE values using your choice of these 
formulas: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 1 
 Cum ACWP + [BAC – cum BCWP] 
 Cum ACWP + [BAC – cum BCWP] / [CPI * SPI] 2 
 Cum ACWP + [[cum BCWS + ETC] – cum BCWP] 

 BAC 
 BAC / CPI 2 

1 The Gate Month is used to report Actual values through the Gate Month and 
ETC values are reported after the Gate Month.  

2 Since this calculation involves division, a simple rollup of LRE values is not 
appropriate. The value for each WBS LRE is obtained by calculating the LRE 
at the EOC level then summing the individual LRE's to get the WBS total. 
Parent WBS's are calculated in the same manner and thus are not summed up 
from the child level LRE's. 

Data Formatting Options 
You choose which Cost Element to depict in this report:   

 Prime Dollars 
 Total Burdened 
 Total Cost 
 Total Dollars 

Program Variance Thresholds 
Variance thresholds are used to determine if a WBS element’s 
schedule, cost, or at complete variance are out of tolerance. You 
can enter both a fixed dollar amount and/or a percentage for 
monthly, cumulative, and at complete. If one or more of the 
variances is out of tolerance, the element shown on the report and 
the out of tolerance variances are marked with an asterisk.  

To access the WBS Threshold dialog box, use the WBS Threshold 
field on the WBS applet. 
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2.44  WBS Hierarchy Report 

This report lists the selected WBS elements in a concise tree 
format, which can be a useful cross-reference to customer ID and 
description. 

Conditioning Window 
Access the WBS Hierarchy Report Conditioning Window by 
selecting WBS Hierarchy on the Reports tab. 

Data Selection Options 
You can limit this report to include only a particular WBS leg. 

Report Source 
This report uses the projectnameP.WBS database. 
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2.45  WBS Indented Report 

This report lists the selected WBS elements in an outline format, 
which can be a useful cross-reference to customer ID and charge 
numbers. 

Conditioning Window 
Access the WBS Indented Report Conditioning Window by 
selecting WBS Indented on the Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 

Report Source 
This report uses the projectnameP.WBS database. 
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2.46  Weekly Report 

The Weekly icon on the Reports tab provides three reports: 

 Weekly Performance reports weekly data by 
WBS; format is similar to a Cost Performance 
report. 

 Weekly EOC Detail reports weekly data by 
Element of Cost; displays time-phased values at 
the detail WBS level. 

 Weekly EOC Rollup reports weekly data by Element of 
Cost; displays time-phased values at any level of the 
WBS. 

These reports allow you to report baseline, cumulative 
and/or at complete values on a weekly basis.   

You can track hours and dollars for BCWS, BCWP, ETC 
and ACWP for a period that you define. Note that the 
“=<Current>” formula is not supported on weekly reports 
and exports. 

Conditioning Window 
Access the Weekly Report Conditioning Window by selecting 
Weekly on the Reports tab. 

Selecting the Desired Weekly Report 
You can access all of these reports from the Weekly Report 
Conditioning Window.  Click the Report Type drop-down list box 
and select Performance, EOC Detail or EOC Rollup. 
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2.46.1  Weekly - Performance 
The Weekly Performance report provides a weekly Cost 
Performance – Work Breakdown Structure report for a specified 
week within a specified three month window. The format of this 
report is similar to a Cost Performance Report (CPR).  

With the Weekly Performance report you can report weekly values 
along with cumulative and at complete values. Values display in 
Hours and Prime Dollars for BCWS, BCWP, ACWP, SV and CV.  
A separate report must be generated for each week. 

This report will include at complete data even if weekly data has 
never been posted.  If you run the report before posting data and 
select the Cum from Inception option, both cumulative and at 
complete values will be reported. Note that the “=<Current>” 
formula is not supported on weekly reports and exports. 

Conditioning Window 
Access the Weekly Report Conditioning Window by selecting 
Weekly on the Reports tab.  To view conditioning options for the 
Weekly Performance report, set Report Type to Performance. 

Data Selection Options 
You can limit these reports to include: 

 a particular WBS leg, element type, or level of the 
WBS 

 specific WBS Aliases, Managers, Cross-
References, recurring/nonrecurring items 

 OBS performing/responsible departments, a 
specific department, a specific CLIN 

Data Inclusion Options 
You can also choose to include in these reports: 

 Cumulative from Inception or Month to Date values 
 Elements of Cost 

Data Calculation Options 
You can choose to calculate LRE values using your choice 
of these formulas: 

 Cum ACWP + ETC 
 Cum ACWP through Gate Month + ETC 

Data Formatting Options 
 You can display dollars in Whole Numbers, 

Thousands, or Decimal Thousands. 
 You can include Grand Totals. 

Report Source 
This report uses the projectnameU.RRH, projectnameW.RRD, 
projectnameP.WBS, and projectnameF.WRD files.
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2.46.2  Weekly - EOC Detail / Rollup 
The Weekly EOC Detail report displays data at the detail 
WBS level.  The Weekly EOC Rollup report displays data 
at any level of the WBS. 

These reports will include data even if weekly data has 
never been posted. If you run the report before posting 
data and select the At Complete Values option, at complete 
values will be included in the report. If you select the Cum 
from Inception option, cumulative values will be reported.  

You may include a maximum of 12 weeks on a Weekly EOC 
report. If the report start and report end you select encompasses 
more than 12 weeks, you will get an error. Note that the 
“=<Current>” formula is not supported on weekly reports and 
exports. 

Conditioning Window 
Access the Weekly Report Conditioning Window by selecting 
Weekly on the Reports tab.  To view conditioning options for the 
Weekly EOC reports, set Report Type to either EOC Detail or 
EOC Rollup. 

Data Selection Options 
You can limit these reports to include: 

 a particular WBS leg, element type, or level of the 
WBS 

 specific WBS Aliases, Managers, Cross-
References, recurring/nonrecurring items 

 OBS performing/responsible departments, a 
specific department, a specific CLIN 

Data Inclusion Options 
You can also choose to include in these reports: 

 Report Timeframe 
• Incremental  
• Cumulative 
• At-complete values 

 Elements of Cost 
 Cost Elements  

• EQP  
• Standard Hours  
• Hours 
• Prime  
• Overhead  
• Total Burdened  
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 
• Total Price 

These options are displayed as check boxes for 
each individual combination, for example Overhead 
(EOC Section) prompts if you want to add a 
subtotal for Overhead to the EOC section of the 
report. Place check marks next to all totals and 
subtotals you want to include. 
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 Element Types  
• BCWS  
• BCWP  
• ACWP  
• SV  
• CV  
• SPI  
• CPI 
• ETC 

Data Calculation Options 
You can choose to calculate cumulative values from 
Inception (Project Start date) or Report Start (the Report 
Week date you select under Report Timeframe). 

Data Formatting Options 
You can add Page Breaks between WBS Elements if 
desired. 

Report Source 
This report uses the projectnameU.RRH, projectnameW.RRD, 
projectnameP.WBS, and projectnameF.WRD files. 

 
 



2.46.2a  Weekly – EOC Detail 
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2.46.2b  Weekly – EOC Rollup 
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2.47  Work Authorization Document 

The Work Authorization Document is a tabular report which 
provides task descriptions, milestones, and financial status and 
history of each WBS element. You can use this report to display 
scope, schedule, and budget for any level of the WBS, and can be 
circulated as an in-house approval document. 

Conditioning Window 
Access the Work Authorization Document Report Conditioning 
Window by selecting Work Authorization Document on the 
Reports tab. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 

 specific WBS Aliases, Managers, Cross-References, 
recurring/nonrecurring items 

 OBS performing/responsible departments, a specific 
department, a specific CLIN 

 a specified number of years 

Data Inclusion Options 
You can choose to include: 

 Report Timeframe 
• Incremental 
• Cumulative values 

 Cost Elements:  
• Standard Hours 
• Hours 
• Prime 
• Overhead 

• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Fee 
• Total Price 
• Grand Totals 

 Task Descriptions 

 Milestones 

 Monthly Financials 

 Financial Recap  

Report Timeframe Information 
You set the Report Start Date for the Monthly Section and the 
Recap Section. 

Data Calculation Options 
You can choose to calculate cumulative values from Inception 
(Project Start date) or Report Start (the Report Start date you enter 
under Report Timeframe).  

Data Formatting Options 
You can display dollars in Whole Numbers, Thousands, or Decimal 
Thousands. 

Funding Amount Field 
In the actual Work Authorization report produced by MPM, MPM 
adds a free-form field called Funding Amount. You can use the 
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Report Viewer to enter a dollar figure in the field when it generates 
the report. 

Report Source 
This report uses the files projectnameU.RRH and 
projectnameW.RRD. 
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2.48  Work Status Document 

The Work Status Documents are tabular reports which provide task 
descriptions, milestones, and financial status and history of each 
WBS element.  

You can use these reports to display scope, schedule, budget, 
actuals and ETC for any level of the WBS, and they can be 
circulated as an in-house change control document. 

Conditioning Window 
Access the Work Status Document Report Conditioning Window 
by selecting Work Status Document on the Reports tab. 

Report Types Available 
 Earned Value shows earned value of each WBS. 
 Budget/LRE shows budget versus actuals comparison of 

each WBS. 

Data Selection Options 
You can limit this report to include only: 

 a particular WBS leg, element type, or level of the WBS 
 specific WBS Aliases, Managers, Cross-References, 

recurring/nonrecurring items 
 OBS performing/responsible departments, a specific 

department, a specific CLIN 
 a specified number of years 

Data Inclusion Options 
You can choose to include: 

 Report Timeframe 
• Incremental  
• Cumulative values 

 Cost Elements 
• Standard Hours 
• Hours/Units 
• Prime  
• Overhead 
• Total Burdened 
• G&A 
• Total Cost 
• Cost of Money 
• Total Dollars 
• Grand Totals 

 Task Descriptions 
 Milestones 
 Monthly Financials 
 Financial Recap 
 Cost Performance Summary 

Report Timeframe Information 
You set the Report Start Date for the Monthly Section and the 
Recap Section 
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Data Calculation Options 
 You can choose to calculate cumulative values from 

Inception (Project Start date) or Report Start (the Report 
Start date you enter under Report Timeframe).  

 LRE can be calculated as Cum ACWP + ETC, Cum ACWP 
through Gate Month + ETC, cum ACWP  + ((BAC - cum 
BCWP) / (CPI * SPI)), or BAC / CPI. 

Data Formatting Options 
You can display dollars in Whole Numbers, Thousands, or Decimal 
Thousands. 

Report Source 
These reports use the files projectnameU.RRH and 
projectnameW.RRD. 

 

 

 



2.48.1  Work Status Document – Earned Value 
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2.48.2  Work Status Document – Budget/LRE 
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